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Safety warning notice

/\ WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not
place the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface,
such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact the
skin or a soft surface, such as pillows or rugs or clothing, during operation. The device and the AC
adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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Product description

Category

Description

Product Name

HP EliteBook 2570p Notebook PC

Processors ®  Infel® Dual Core® i7-3520M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-
MHz FSB, 4.0-MB L3 cache, 35 W)
e Infel Dual Core i5-3360M 2.80-GHz processor (SC turbo up to 3.50-GHz; 1600-MHz
FSB, 3.0-MB L3 cache, 35 W)
e Infel Dual Core i5-3320M 2.60-GHz processor (SC turbo up to 3.30-GHz; 1600-MHz
FSB, 3.0-MB L3 cache, 35 W)
e Intel Dual Core i5-3210M 2.50-GHz processor (SC turbo up to 3.10-GHz; 1600-MHz
FSB, 3.0-MB L3 cache, 35 W)
e Intel Core i3-3110M 2.40-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W)
Chipset Mobile Intel QM77 chipset
Graphics Intel HD Graphics 4000 integrated universal memory architecture (UMA) graphics
Panel 12.5-in light-emitting diode (LED), high-definition (HD), AntiGlare (AG), SVA (1368x768)
display with and without webcam and microphone
All display assemblies include two wireless local area network (WLAN) antenna cables and
two wireless wide area network (WWAN) antenna cables
Support for low voltage differential signalling (LVDS)
Support for optional privacy filter
Memory Two customer-accessible/upgradable memory module slots

Support for DDR3-12800 (1600-MHz) dual channel

Support for 16384-MB of system RAM in the following configurations:
o 16384-MB (8192-MBx2, dual channel)

e 12288-MB (8192-MBx1+4096-MBx1, dual channel)

e 8192-MB (8192-MBx1 or 4096x2, dual channel)

o 4096-MB (4096-MBx1 or 2048-MBx2, dual channel)

o 2048-MB (2048x1)




Category Description

Hard drive Support for 6.35-cm (2.5-in) hard drives in 9.5-mm (.37-in) and 7.0-mm (.28-in) thicknesses

(all hard drives use the same bracket)

Customer-accessible

Serial ATA

Support for the following hard drives:

e  750-GB, 7200-rpm, 9.5-mm

e 500-GB, 7200-rpm, 7.0-mm self-encrypting drive (SED)
e  500-GB, 7200-rpm, 7.0-mm

e  320-GB, 7200-rpm, 7.0-mm

Solid-state drive Solid-state drive (SSD) mounts in the same bracket as the hard drive
Customer-accessible
Serial ATA type Il and lII
Support for the following SSDs:

e 256-GB self-encrypted drive (SED) lll

e  240-GB Il

e 180GBII

e 160-GBII

e 128GBIl
Optical drive Fixed

Customer-accessible

Support for the following drive options:

e DVD=RW Double-layer with SuperMulti Drive
e  DVD-ROM Drive

Support for no drive option

Audio and video Two stereo speakers
HD audio with SRS Premium Sound PRO
Integrated 720p HD webcam
Support for no camera option
Integrated dual-array microphone on computer models equipped with a webcam

Integrated mono microphone on computer models not equipped with a webcam

Chapter 1 Product description



Category Description

Ethernet Intel 82579LM 10/100/1000 Ethernet network interface card (NIC)
NIC Power Down technology
S3/54/S5 wake on LAN

Ethernet cable not included

Wireless Integrated wireless personal area network (WPAN) option by way of Bluetooth 4.0 enhanced
data rate (EDR) module

Support for no WPAN option

Integrated wireless local area network (WLAN) options by way of wireless module
Two WLAN antennas built into display assembly

Support for the following WLAN formats:

e Atheros WB225 1x1 802.11b/g/n Bluetooth Combo Adapter

e  Broadcom 43228 802.11abgn 2x2 Wi-Fi Adapter

e Infel Centrino Advanced-N 6205 WLAN module

Support for no WLAN option

Integrated wireless wide area network (WWAN) options by way of wireless module
Two world-wide/5-band WWAN antennas built into display assembly

Secured by subscriber identity module (SIM, user-accessible behind battery)

Support for the following WWAN formats:

e HP hs2350 HSPA+ Mobile Broadband Module

e HPIt2523 LTE/HSPA+ Mobile Broadband Module

e HP [t2522 LTE/EV-DO Mobile Broadband Module

e  HP un2430 EV-DO/HSPA Mini Card

e  HP un2430 EV-DO/HSPA Mobile Broadband Module

Support for no WWAN option

Support for WWAN after market option




Category Description

External media cards 34-mm ExpressCard slot
Integrated Smart Card reader

Secure Digital (SD) Media reader slot with push-push technology, supporting the following
digital card formats:

e  MultiMediaCard (MMC)
e  MMC+

e Secure Digital (SD) Memory Card

e SDHC
e SDXC
Ports e Audio-in (mono microphone)/audio-out (stereo headphone) combo jack

e  Battery connector

e DisplayPort 1.1

e Docking connector

e  eSATA/USB 3.0 combo port
e HP Smart AC adapter

e RJ-45 (Ethernet)

e RJI11 (modem)

e USB 3.0 port

e  USB 2.0 charging port

e VGA (Dsub 15-pin) supporting: 1920x1200 external resolution @ 75 Hz, hot plug and
unplug and auto-detection for correct output fo wide-aspect vs. standard aspect video

Keyboard/pointing Chiclet-style keyboard with numeric keypad (upper-left justified), dual-point, spill-resistant with
devices drain, durakeys, backlit (optional)

Gesture support: MultiTouch gestures enabled, two-finger scrolling, and pinch-
zoom as default

Taps enabled by default
Support for TouchPad with image sensor

Support for 2-way scroll

Power requirements Support for the following AC adapters:
e 65W HP Smart AC adapter (PFC, RC/V, EM, 3-wire)
e  65W HP Smart AC adapter (non-PFC, RC/V, 3-wire)

e 65W HP Travel AC adapter (non-PFC, 3-wire)
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Category

Description

Power requirements

Support for the following batteries:

(Continued)
o 9<ell, 100-Wh, 3.00-Ah
e 6cell, 62-Wh, 2.80-Ah
o  6cell, 55-Wh, 2.80-Ah
e  3-cell, 31-Wh, 2.80-Ah
Security Support for security cable lock

Support for fingerprint reader and no fingerprint reader option

Support for Trusted Platform Module (TPM) 1.2 (Infineon, soldered down) and TPM Enhanced
Drive Lock (not supported in Asia and the People's Republic of China)

Integrated Smart Card reader (active)

Full volume encryption

Preboot authentication (password, Smart Card)

Operating system

Preinstalled:

Windows® 8 ML 64 with Microsoft Basics (Japan only)

Windows 8 Professional 64 with Microsoft Basics (Japan only)

Windows 8 Professional 64 DPK with Windows 7 Professional 64 and 32 (Japan only)
Windows 7 Home Premium 64 and 32 with Microsoft Basics

Windows 7 Professional 64 and 32 with Microsoft Basics

Windows 7 Service Pack 1

FreeDOS

SUSE Linux (SLED; People's Republic if China only)
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Category

Description

Operating system
(Continued)

Preinstalled with Microsoft Office:

e Windows 8 CH 64-bit with Office 2010 Transition OPK (People's Republic of
China only)

®*  Windows 8 EM 64-bit with Office 2010 Transition OPK (not available in Japan)

e Windows 8 ML 64-bit with Office 2010 Business and Home (Japan only; requires
configuration with Office Personal Japan 2010 app AV)

®  Windows 8 ML 64-bit with Office 2010 Personal (Japan only; requires configuration
with Office Personal Japan 2010 app AV)

e Windows 8 ML 64-bit with Office 2010 Professional (Japan only; requires configuration
with Office Personal Japan 2010 app AV)

e Windows 8 ML 64-bit with Office 2010 Transition OPK (not available in Japan)

®  Windows 8 Professional 64-bit DPK with Windows 7 Professional 64- and 32-bit with
Office 2010 Business and Home (Japan only; requires configuration with Office
Personal Japan 2010 app AV)

e  Windows 8 Professional 64-bit DPK with Windows 7 Professional 64- and 32-bit with
Office 2010 Personal (Japan only; requires configuration with Office Personal Japan
2010 app AV)

®  Windows 8 Professional 64-bit DPK with Windows 7 Professional 64- and 32-bit with
Office 2010 Professional (Japan only; requires configuration with Office Personal Japan
2010 app AV)

e  Windows 8 Professional 64-bit DPK with Windows 7 Professional 64- and 32-bit with
Office 2010 Starter (not available in Asia-Pacific countries and regions, Japan, or the
People's Republic of China)

e Windows 8 Professional 64-bit with Office 2010 Business and Home (Japan only;
requires configuration with Office Personal Japan 2010 app AV)

®  Windows 8 Professional 64-bit with Office 2010 Personal (Japan only; requires
configuration with Office Personal Japan 2010 app AV)

®  Windows 8 Professional 64-bit with Office 2010 Professional (Japan only; requires
configuration with Office Personal Japan 2010 app AV)

®  Windows 8 Professional 64-bit with Office 2010 Transition OPK (not available
in Japan)

®  Windows 7 Home Basic 32-bit with Office Starter (emerging markets only)

e Windows 7 Home Premium é4- and 32-bit with Office Starter (not available in Japan)

®  Windows 7 Home Premium 64-bit with Office 2010 Personal (only in Japan)

e Windows 7 Home Premium 64-bit with Office 2010 Home & Business (only in Japan)

®  Windows 7 Home Premium 6é4-bit with Office 2010 Personal (only in Japan)

e Windows 7 Home Premium 64-bit with Office 2010 Professional (only in Japan)

(Continued)
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Category

Description

Operating system
(Continued)

Preinstalled with Microsoft Office: (Continued)

Windows 7 Professional 64- and 32-bit with Office 2010 Starter (not available
in Japan)

Windows 7 Professional 64- and 32-bit with Office 2010 Business & Home (only
in Japan)

Windows 7 Professional 64- and 32-bit with Office 2010 Personal (only in Japan)

Windows 7 Professional 64- and 32-bit with Office 2010 Professional (only in Japan)

Restore media—0OS-DVD:

Windows 7 Professional 64- and 32-bit with Office 2010 Starter (not available
in Japan)

Windows 7 Professional 64- and 32-bit with Office 2010 Business & Home (only
in Japan)

Windows 7 Professional 64- and 32-bit with Office 2010 Personal (only in Japan)

Windows 7 Professional 64- and 32-bit with Office 2010 Professional (only in Japan)

Restore media—DR-DVD:

Windows 8 (available with any Windows 8 operating system and required with
Windows 8 Professional 64-bit DPK with Windows 7 image)

Windows 7 (available with any Windows 7 HP, Windows 7 Professional loc, Windows
7 HB, or Windows 8 Professional 64-bit DPK with Windows 7 image)

Restore media—0OS-DVD:

®  Windows 8 Professional 64-bit (required with Windows 8 Professional 64-bit DPK with
Windows image)

®  Windows 7 Home Basic 32-bit (available with any Windows 7 Home Basic location
except Asia-Pacific countries and regions and the People's Republic of China)

®  Windows 7 Home Premium 64- and 32-bit (available with any Windows 7 Premium
location except Asia-Pacific countries and regions and the People's Republic of China)

®  Windows 7 Professional 64- and 32-bit (available with any Windows 7 Professional or
Windows 8 Professional 64-bit DPK with Windows image location except Asia-Pacific
countries and regions and the People's Republic of China)

Certified:

®  Microsoft WHQL

®  SUSE Linux Enterprise (SLED) 64-bit Service Pack 2




Category Description

Operating system Web-only support:
(Continued)
e Windows XP Pro 32-bit
e Windows 7 Enterprise 64- and 32-bit

e Windows 7 Ultimate 64- and 32-bit

Serviceability End user replaceable parts:
e AC adapter

®  Battery

Hard drive

Keyboard

e Memory module

Solid-state drive

WILAN module

WWAN module

Chapter 1 Product description



2 External component identification

Item

Component

Description

m

WILAN antennas (2)*

Send and receive wireless signals to communicate
with WLANSs (select models only).

(2)

WWAN antennas (2)*

Send and receive wireless signals to communicate

with WWAN:E (select models only).

(3)

Internal microphones (2)

Record sound.

(4)

Webcam light (select models only)

On: The webcam is in use.

Display



Item Component Description

(5) Webcam (select models only) Records video and captures still photographs.
For information on using the webcam:
®  Windows 8 — Access Help and Support. From the

Start screen, type h, and then select Help and
Support.

e Windows 7 — Select Start > All Programs >
Communication and Chat > HP Webcam.

(6) Keyboard light Provides light for the keyboard.
(7) Keyboard light button and ambient Turns on the keyboard light and automatically adjusts the
light sensor display brightness based on the lighting conditions in

your environment.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antennas free from obstructions. To see wireless regulatory notices, see the section of the Regulatory, Safety, and
Environmental Notices that applies to your country or region.

Buttons and fingerprint reader (select models only)

%) D@

et
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Item

Component

Description

(1) Power button e When the computer is off, press the power button to
turn on the computer.
®  When the computer is on, press the power button
briefly to initiate Sleep.
®  When the computer is in the Sleep state, press the
power button briefly to exit Sleep.
e  When the computer is in Hibernation, press the
power button briefly to exit Hibernation.
CAUTION: Pressing and holding the power button
for emergency shutdown will result in loss of unsaved
information.
If the computer has stopped responding and Windows
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off
the computer.
To learn more about your power settings:
e Windows 8 — From the Start screen, type power,
select Settings, and then select Power Options.
e Windows 8 — Select Windows 7 > Start >
Control Panel > System and Security >
Power Options, or refer to the HP Notebook
Reference Guide.
(2) Wireless button Turns the wireless feature on or off, but does not establish
a wireless connection.
(3) Web browser button Opens the default Web browser.
(4) Volume mute button Mutes and restores speaker sound.
(5) Fingerprint reader (select models only) Allows a fingerprint logon instead of a password logon.

Buttons and fingerprint reader (select models only)
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Keys

@NOTE: Your computer may look slightly different from the illustration in this section.

©@©@®®

Item Component Description

(1) esc key Displays system information when pressed in combination
with the fn key.

(2) fn key Executes frequently used system functions when pressed
in combination with a function key, the num Ik key, the
esc key, or other keys.

(3) Windows logo key Displays the Windows Start menu.

(4) Function keys Execute frequently used system functions when pressed in
combination with the fn key.

(5) Embedded numeric keypad When the keypad is turned on, it can be used like an
external numeric keypad.

NOTE: The embedded numeric keypad will not function
while an external keyboard or numeric keypad is
connected to the computer

(6) Windows applications key Displays a shortcut menu for items beneath the cursor.

12 Chapter 2 External component identification



Lights

&
Item Component Description
(1) Power light e White: The computer is on.
e Blinking: The computer is in the Sleep state.
e Off: The computer is off or in Hibernation.
(2) Num lock light White: Num lock is on.
(3) Wireless light e White: An integrated wireless device, such as a
WILAN device, a WWAN device, and/or a
Bluetooth device, is on.
e Amber: All wireless devices are off.
(4) Web browser light e  On: The computer is on.
e Off: The computer is off or in Hibernation.
(5) Mute light e White: Computer sound is on.
e Amber: Computer sound is muted.
(6) Caps lock light White: Caps lock is on.
(7) TouchPad on/off light e Amber: The TouchPad is off.

o Off: The TouchPad is on.

Lights

13



TouchPad

14

&
Fi
Item Component Description
(1) Pointing stick Moves the pointer and selects or activates items on
the screen.
(2) Left pointing stick button Functions like the left button on an external mouse.
(3) TouchPad on/off button Turns the TouchPad on or off.
(4) TouchPad zone Moves the pointer and selects or activates items on
the screen.
(5) Left TouchPad button Functions like the left button on an external mouse.
(6) Right pointing stick button Functions like the right button on an external mouse.
(7) Right TouchPad button Functions like the right button on an external mouse.

Chapter 2 External component identification



Item Component Description

(1) Wireless light e White: An integrated wireless device, such as a
WLAN device, a WWAN device, and/or a
Bluetooth device, is on.

e Amber: All wireless devices are off.

(2) Power light e White: Power is on.
e  Blinking white: The computer is in the Sleep state.

e Off: The computer is off or in Hibernation.

(3) Battery light e White: A battery is close to full charge capacity.

e Amber: A battery that is the only available power
source has reached a low battery level. When the
battery reaches a critical battery level, the battery
light begins blinking rapidly.

e Off: If the computer is plugged into an external
power source, the light turns off when all batteries in
the computer are fully charged. If the computer is
not plugged into an external power source, the light
stays off until the battery reaches a low battery level.

(4) Drive light e White: The hard drive or optical drive is
being accessed.

e Amber: HP 3D DriveGuard has temporarily parked
the hard drive.

(5) Vents (3) Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.

Front 15



Left side

16

Item Component Description

(M Power connector Connects an AC adapter.

(2) RJ-45 (network) jack Connects a network cable. The RJ-45 jack has two
activity indicator lights.
®  Amber: Activity is occurring on the network.
e  Green: The network is connected.

(3) RJ-11 (modem) jack (select models only) Connects a modem cable.

(4) Optical drive Reads and writes (select models only) to an optical disc.

(5) Optical drive light ®  On: The optical drive is being accessed.
e Off: The optical drive is idle.

(6) Smart Card reader Supports optional smart cards.

Chapter 2 External component identification



Rear

&

Item Component Description

(1) External monitor port Connects an external VGA monitor or projector.

(2) USB port Connects an optional USB device.

(3) USB 3.0 port Connects an optional USB 1.0, USB 2.0, or USB 3.0

device and provides enhanced USB power performance
for USB 3.0 devices.

Rear

17



Right side

@ OB @@

Item Component Description
(1) ExpressCard slot Supports optional 34-mm ExpressCards.
(2) Media Card Reader Supports MultiMediaCard and Secure Digital (SD) Card
digital card formats.
(3) Audio-out (headphone) jack/Audio-in Connects optional powered stereo speakers,
(microphone) jack headphones, earbuds, a headset, or television audio.

Also connects an optional headset microphone.

WARNING! To reduce the risk of personal injury,
adjust the volume before putting on headphones,
earbuds, or a headset. For additional safety information,
refer to the Regulatory, Safety, and

Environmental Notices..

NOTE: When a device is connected to the jack, the
computer speakers are disabled.

NOTE: A 4-conductor audio jack plug headphone with
microphone is needed in order to use the
microphone function.

(4) DisplayPort Connects an optional digital display device, such as a
high-performance monitor or projector.

(5) eSATA/USB 2.0 combo port Connects a high-performance eSATA component, such as
an eSATA external hard drive, or connects an optional
USB device.

(6) Vents (2) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
infernal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.

(7) Docking connector Connects an optional docking device.

(8) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.
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Item

Component

Description

m

Service cover

Contains the hard drive, the WLAN module slot, the
WWAN module slot, and the memory module slofs.

CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country or
region. If you replace the module and then receive a
warning message, remove the module to restore
computer functionality, and then contact support through
Help and Support.

(2)

Service cover release latch

Releases the cover for the hard drive bay and memory
module slots.

NOTE: A service cover screw is under the release latch.

3)

Battery bay

Holds the battery.

4)

Battery release latch

Releases the battery.

(5)

SIM slot

Supports a wireless subscriber identity module (SIM). The
SIM slot is located inside the battery bay.

Bottom
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Item Component

Description

(6) Vents

Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.

(7) Bluetooth module compartment

Holds the Bluetooth device.

(8) Speaker

Produces sound.
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Service tag

When ordering parts or requesting information, provide the computer serial number and model number
provided on the service tag. It is necessary to remove the battery to obtain these numbers. See Battery
on page 50 for battery removal instructions.

OO0
©—7 Serial: X0000000C (INITNINANNNNWAINNN

—Produd: JOOOOKXX IIMNMEmNIRNNNIN
mﬁmr 1ylyOy

Item Description Function

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.

(3) Part number/Product number (p/n) This number provides specific information about the
product's hardware components. The part number
helps a service technician to determine what
components and paris are needed.

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.
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Item Component Spare part number

(1) Display assembly: The display assembly is spared at the subcomponent level only. For more display assembly
spare part information, see Display assembly subcomponents on page 29.

(2) Keyboard with pointing stick (includes keyboard cable and pointing stick cable):

For use only on computer models equipped with the Windows 8 operating system:

For use in Belgium 701979-A41
For use in Brazil 701979-201
For use in Bulgaria 701979261
For use in Canada 701979-DB1
For use in the Czech Republic and Slovakla 701979FL1

For use in Denmark 701979081
For use in France 701979-051
For use in Germany 701979-041
For use in Greece 701979-151
For use in Hungary 701979-211
For use in Iceland 701979-DD1
For use in India 701979-D61
For use in Israel 701979-BB1
For use in ltaly 701979-061
For use in Japan 701979-291
For use in Latin America 701979-161
For use in the Netherlands 701979831
For use in Norway 701979-091
For use in Northwest Africa 701979FP1

For use in Portugal 701979-131
For use in Romania 701979-271
For use in Russia 701979-251
For use in Saudi Arabia 701979171
For use in Slovenia 701979-BA1
For use in South Korea 701979-AD1
For use in Spain 701979-071
For use in Sweden and Finland 701979871
For use in Switzerland 701979-BG1
For use in Taiwan 701979-AB1
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Item Component Spare part number
For use in Thailand 701979-281
For use in Turkey 701979-141
For use in the United Kingdom and Singapore 701979031
For use in the United States 701979-001
For use only on computer models equipped with the Windows 7 operating system:

For use in Belgium 696693-A41
For use in Brazil 696693-201
For use in Bulgaria 696693261
For use in Canada 696693-DB1
For use in the Czech Republic and Slovakia 696693-FL1

For use in Denmark 696693081
For use in France 696693-051
For use in Germany 696693-041
For use in Greece 696693-151
For use in Hungary 696693-211
For use in Iceland 696693-DD1
For use in India 696693-D61
For use in Israel 696693-BB1
For use in Italy 696693-061
For use in Japan 696693-291
For use in Latin America 696693-161
For use in the Netherlands 696693831
For use in Norway 696693-091
For use in Northwest Africa 696693-FP1

For use in Portugal 696693-131
For use in Romania 696693-271
For use in Russia 696693-251
For use in Saudi Arabia 696693-171
For use in Slovenia 696693-BA1
For use in South Korea 696693-AD1
For use in Spain 696693-071
For use in Sweden and Finland 696693871

Computer major components
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Item Component Spare part number
For use in Switzerland 696693-BG1
For use in Taiwan 696693-AB1
For use in Thailand 696693-281
For use in Turkey 696693-141
For use in the United Kingdom and Singapore 696693-031
For use in the United States 696693-001
(3) RTC battery (includes cable and double-sided adhesive) 665733001
(4) Top cover (includes TouchPad and TouchPad cable):
NOTE: The TouchPad cable is also available in the Cable Kit, spare part number 651384-001.
For use on computer models equipped with a fingerprint reader 685407001
For use on computer models not equipped with a fingerprint reader 685406001
Bracket Kit (not illustrated includes top cover left and right brackets) 651381-001
(5) Power button board (includes cable) 685408-001
(6) Smart Card reader assembly (includes Smart Card reader cable and function 685503-001
LED board cable)
(7) Function LED board 685509-001
(8) Fingerprint reader board (includes bracket and cable) 685410001
(9) Function button board (includes cable) 685409-001
(10) System board (includes replacement thermal material):
For use only on computer models equipped with the Windows 8 Professional 685404-601
operating system in all countries and regions except the People's Republic of China
and the Ukraine
For use only on computer models equipped with the Windows 8 Standard operating 685404-501
system in all countries and regions except the People's Republic of China and the
Ukraine
For use only on computer models equipped with the Windows 7 operating system in 685404-001
all countries and regions except the People's Republic of China and the Ukraine
For use only on computer models equipped with the Windows 7 operating system in 692857001
the People's Republic of China and the Ukraine
(11) Processor (includes replacement thermal material)
Intel Dual Core i7-3520M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz  681954-001
FSB, 4.0-MB L3 cache, 35 W)
Intel Dual Core i5-3360M 2.80-GHz processor (SC turbo up to 3.50-GHz; 1600-MHz  681953-001
FSB, 3.0-MB L3 cache, 35 W)
Intel Dual Core i5-3320M 2.60-GHz processor (SC turbo up to 3.30-GHz; 1600-MHz 681952001

FSB, 3.0-MB L3 cache, 35 W)
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Item Component Spare part number
Intel Dual Core i5-3210M 2.50-GHz processor (SC turbo up to 3.10-GHz; 1600-MHz  680645-001
FSB, 3.0-MB L3 cache, 35 W)
Intel Core i3-3110M 2.40-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W) 682417001
(12) Heat sink (includes replacement thermal material) 685508-001
(13) Optical drive (includes bezel and bracket):
DVD+RW Double-layer with SuperMulti Drive 685502001
DVD-ROM Drive 685419-001
(14) Base enclosure (includes 4 rubber feet, battery release latch assembly, service cover 685403-001
release latch assembly, and replacement thermal material)
Latch Kit (not illustrated, includes battery release latch assembly components and 685505-001
service cover release latch assembly components)
Rubber Kit (not illustrated, includes base enclosure and display bezel screw covers)  651382-001
(15) Battery (Li-ion):
9-cell, 100-Wh, 3.00-Ah 632423-001
6-cell, 62-Wh, 2.80-Ah 632421-001
6-cell, 55-Wh, 2.80-Ah 632419-001
3-cell, 31-Wh, 2.80-Ah 632417-001
(16) Modem module (56k v.92 MDC data/fax, does not include cable) 628824-001
NOTE: The modem module does not include a cable. The modem module cable is
included in the Cable Kit, spare part number 651384-001. See Cable Kit
on page 31 for more Cable Kit information.
17) WWAN module:
HP hs2350 HSPA+ Mobile Broadband Module 710788001
HP 12523 LTE/HSPA+ Mobile Broadband Module 710790-001
HP 12522 LTE/EV-DO Mobile Broadband Module 710789-001
HP un2430 EV-DO/HSPA Mini Card 702080-001
HP un2430 EV-DO/HSPA Mobile Broadband Module 634400-001
(18) WLAN module:
Atheros WB225 1x1 802.11b/g/n Bluetooth Combo Adapter 675794-001
Broadcom 43228 802.11abgn 2x2 Wi-Fi Adapter 669832-001
Intel Centrino Advanced-N 6205 WLAN module 631954-001
(19) Speaker assembly (includes cable) 651377001

Computer major components
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Item Component Spare part number
(20) Bluetooth module (4.0 EDR) 655792-001
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module
cable. The Bluetooth module cable is included in the Cable Kit, spare part number
693306-001.
(21) Memory modules (2, PC3-12800, 1666-MHz, DDR3):
8-GB 670034-001
4-GB 641369-001
2-GB 652972-001
(22) Hard drive (does not include hard drive bracket, hard drive connector adapter, or screws):
750-GB, 7200-rpm, 9.5-mm 633252-001
500-GB, 7200-rpm, 9.5-mm self-encrypting drive 683801-001
500-GB, 7200-rpm, 9.5-mm 634925-001
320-GB, 7200-rpm, 9.5-mm 634862-001
Hard Drive Hardware Kit (not illustrated, includes hard drive bracket, hard drive  651380-001
connector adapter, and screws)
Solid-state drive (not illustrated, does not include bracket, connector, or screws):
256-GB SATA Il self-encrypting solid-state drive 697058-001
240-GB SATA Il solid-state drive 701657-001
180-GB SATA lll solid-state drive 700995-001
160-GB SATA |l solid-state drive 697060-001
128-GB SATA Il solid-state drive 697057-001
(23) Fan (includes cable) 651378-001
(24) Service cover:
Includes label indicating “Made in China” 685400-001
Includes label indicating country of origin 703148001
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Display assembly subcomponents

Item Component Spare part number
(1) Display bezel:

For use on computer models equipped with a webcam 685411001

For use on computer models not equipped with a webcam 685412-001
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Item Component Spare part number
(2) 12.5 in, HD, LED, AG, SVA display panel 685504-001
Display Hinge Kit, includes: 685414-001
(3) Left and right display hinges
Display Hinge Cover Kit, includes: 685405-001
(4a) Left and right display hinge caps
(4b) Left and right display hinge covers
(4c) Display clutch cover
Antenna Kit, includes: 685506-001
(5a) WILAN antenna cables and transceivers
(5b) WWAN antenna cables and transceivers
(6) Webcam/microphone module 685413-001
Microphone module 694675-001
Display Cable Kit, includes: 685417-001
(7) Display panel cable and webcam/microphone module cable
(8) Display enclosure 685415-001
Display Panel Support Kit (not illustrated, includes display enclosure, WLAN 685507-001
antenna cables and transceivers, and WWAN antenna cables and transceivers)
Display Screw Kit (not illustrated) 685418-001
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Cable Kit
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Item Component Spare part number
Cable Kit, includes: 651384-001

(1) Bluetooth module cable

(2) Modem module cable
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Mass storage device

O—yy,

‘F"‘/

—o

Item Description Spare part number
(1) Hard drive (does not include hard drive bracket, hard drive connector adapter, or screws):

750-GB, 7200-rpm, 9.5-mm 633252-001

500-GB, 7200-rpm, 9.5-mm SED 683801-001

500-GB, 7200-rpm, 9.5-mm 634925-001

320-GB, 7200-rpm, 9.5-mm 634862-001

Hard Drive Hardware Kit, includes: 651380-001

(2a) Hard drive bracket

(2b) Hard drive connector adapter

Hard drive bracket screws (not illustrated)

(3) Optical drive (includes bezel and bracket):
DVD+RW Double-Layer with SuperMulti Drive 685502001
DVD-ROM Drive 685419-001
(4) Solid-state drive (does not include bracket, connector adapter, or screws):
256-GB SATA Il self-encrypting solid-state drive 697058-001
240-GB SATA lll solid-state drive 701657-001
180-GB SATA lll solid-state drive 700995-001
160-GB SATA Il solid-state drive 697060001
128-GB SATA Il solid-state drive 697057001
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Plastics Kit
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Item Component Spare part number
Plastics Kit, includes: 651376-001

(1) Optical drive bay space saver

(2) ExpressCard slot space saver

(3) RI-11 jack plug
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Miscellaneous parts

Component Spare part number

AC adapter:

65-W HP Smart AC adapter (PFC, RC/V, EM, 3-wire) 693710-001
65-W HP Smart AC adapter (non-PFC, RC/V, 3-wire) 693711-001
65-W HP Travel AC adapter (non-PFC, 3-wire) 693716-001

Computer carrying case:

HP basic carrying case 455084-001
HP essential nylon carrying case 612757-001
HP professional slim top-load carrying case 592923-001

Computer lock:

HP keyed cable lock 626729-002

HP notebook combination lock 591699-001

Computer mouse:

HP optical/USB travel mouse 434594-001
HP optical/USB/PS2 2-button mouse 390632001
HP 2570 Docking Station 685401-001

Power cord (3-pin, black, 1.83-m):

For use in Argentina 490371-D01
For use in Australia 490371011
For use in Brazil 490371-202
For use in Denmark 490371-081
For use in Europe 490371-021
For use in India 490371-D61
For use in Israel 490371-BB1
For use in Japan 490371-291
For use in North America 490371-001
For use in the People's Republic of China 490371-AA1
For use in South Africa 490371-AR1
For use in South Korea 490371-AD1
For use in Switzerland 490371-111
For use in Taiwan 490371-AB1
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Component Spare part number
For use in Thailand 490371-201
For use in the United Kingdom and Singapore 490371031
Screw Kit 685416-001

Sequential part number listing

Spare part number

Description

390632001 HP USB/PS2 2-button optical mouse

434594001 HP USB optical travel mouse

455084-001 HP basic carrying case

490371-001 Power cord for use in North America (3-pin, black, 1.83-m)
490371011 Power cord for use in Australia (3-pin, black, 1.83-m)
490371021 Power cord for use in Europe (3-pin, black, 1.83-m)
490371-031 Power cord for use in the United Kingdom and Singapore (3-pin, black, 1.83-m)
490371-081 Power cord for use in Denmark (3-pin, black, 1.83-m)
490371-111 Power cord for use in Switzerland (3-pin, black, 1.83-m)
490371-201 Power cord for use in Thailand (3-pin, black, 1.83-m)
490371-202 Power cord for use in Brazil (3-pin, black, 1.83-m)
490371-291 Power cord for use in Japan (3-pin, black, 1.83-m)
490371-AA1 Power cord for use in the People's Republic of China (3-pin, black, 1.83-m)
490371-AB1 Power cord for use in Taiwan (3-pin, black, 1.83-m)
490371-AD1 Power cord for use in South Korea (3-pin, black, 1.83-m)
490371-AR1 Power cord for use in South Africa (3-pin, black, 1.83-m)
490371-BB1 Power cord for use in Israel (3-pin, black, 1.83-m)
490371-D01 Power cord for use in Argentina (3-pin, black, 1.83-m)
490371-D61 Power cord for use in India (3-pin, black, 1.83-m)
591699001 HP notebook combination lock

592923-001 HP professional slim top-load carrying case

612757-001 HP essential nylon carrying case

626729-002 HP notebook keyed cable lock
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Spare part number

Description

628824-001 Modem module (56k v.92 MDC data/fax, does not include cable)
NOTE: The modem module does not include a cable. The modem module cable is included in the
Cable Kit, spare part number 651384-001. See Cable Kit on page 31 for more Cable Kit
information.

631954001 Intel Centrino Advanced-N 6205 WLAN module

632417-001 3cell, 31-Wh, 2.80-Ah, Li-ion battery

632419-001 6-cell, 55-Wh, 2.80-Ah, Li-ion battery

632421-001 6-cell, 62-Wh, 2.80-Ah, Li-ion battery

632423-001 9-cell, 100-Wh, 3.00-Ah, Li-ion battery

633252-001 750-GB, 7200-rpm, 9.5-mm hard drive (does not include hard drive bracket, hard drive connector
adapter, or screws)
NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in the
Hard Drive Hardware Kit, spare part number 651380-001.

634400-001 HP un2430 EV-DO/HSPA Mobile Broadband Module

634925-001 500-GB, 7200-rpm, 9.5-mm hard drive (does not include hard drive bracket, hard drive connector
adapter, or screws)
NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in the
Hard Drive Hardware Kit, spare part number 651380-001.

641369-001 4-GB memory module (PC3, 12800, 1600-MHz)

651376001 Plastics Kit (includes ExpressCard slot space saver, optical drive bay space saver, RJ-11 jack plug)
NOTE: See Plastics Kit on page 33 for more Plastics Kit information.

651377001 Speaker assembly (includes cable)

651378-001 Fan (includes cable)

651380-001 Hard Drive Hardware Kit (includes hard drive bracket, hard drive connector adapter, and screws)

651381-001 Bracket Kit (includes top cover left and right brackets)

651382-001 Rubber Kit (includes base enclosure rubber bumpers)

651384-001 Cable Kit (includes Bluetooth module cable and modem module cable)
NOTE: See Cable Kit on page 31 for more Cable Kit information.

652972-001 2-GB memory module (PC3, 12800, 1600-MHz)

655792-001 Bluetooth module 4.0 EDR
NOTE: The Bluetooth module does not include a cable. The Bluetooth module cable is included in
the Cable Kit, spare part number 651384-001. See Cable Kit on page 31 for more Cable Kit
information.

665733001 RTC battery (includes cable and double-sided adhesive)

669832-001 Broadcom 43228 802.11abgn 2x2 Wi-Fi Adapter

670034-001 8-GB memory module (PC3, 12800, 1600-MHz)
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Spare part number  Description

675794-001 Atheros WB225 1x1 802.11b/g/n Bluetooth Combo Adapter

680645-001 Intel Dual Core i5-3210M 2.50-GHz processor (SC turbo up to 3.10-GHz; 1600-MHz FSB, 3.0-MB
L3 cache, 35 W; includes replacement thermal material)

681952-001 Intel Dual Core i5-3320M 2.60-GHz processor (SC turbo up to 3.30-GHz; 1600-MHz FSB, 3.0-MB
L3 cache, 35 W; includes replacement thermal material)

681953-001 Intel Dual Core i5-3360M 2.80-GHz processor (SC turbo up to 3.50-GHz; 1600-MHz FSB, 3.0-MB
L3 cache, 35 W; includes replacement thermal material)

681954-001 Intel Dual Core i7-3520M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz FSB, 4.0-MB
L3 cache, 35 W; includes replacement thermal material)

682417-001 Intel Core i3-3110M 2.40-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W; includes

replacement thermal material)

683801-001 500-GB, 7200-rpm, 9.5-mm SED hard drive (does not include hard drive bracket, hard drive
connector adapter, or screws)

NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in the

Hard Drive Hardware Kit, spare part number 651380-001.

685400-001 Service cover (includes label indicating “Made in China”)
685401-001 HP 2570 Docking Station
685403-001 Base enclosure (includes 4 rubber feet, battery release latch assembly, service cover release latch

assembly, and replacement thermal material)

685404-001 System board for use only on computer models equipped with the Windows 7 operating system in
all countries and regions except the People's Republic of China and the Ukraine (includes
replacement thermal material)

685404-501 [q] System board for use only on computer models equipped with the Windows 8 Standard operating
system in all countries and regions except the People's Republic of China and the Ukraine (includes
replacement thermal material)

685404-601 [a] System board for use only on computer models equipped with the Windows 8 Professional
operating system in all countries and regions except the People's Republic of China and the Ukraine
(includes replacement thermal material)

685405-001 Display Hinge Cover Kit (includes left and right display hinge caps, left and right display hinge
covers, and clutch cover)

685406001 Top cover for use on computer models not equipped with a fingerprint reader (includes TouchPad
and TouchPad cable)

685407-001 Top cover for use on computer models not equipped with fingerprint reader (includes TouchPad and
TouchPad cable)

685408-001 Power button board (includes cable)

685409-001 Function button board (includes cable

685410001 Fingerprint reader board (includes bracket and cable)

685411001 Display bezel for use on computer models equipped with a webcam

685412-001 Display bezel for use on computer models not equipped with a webcam

685413-001 Webcam/microphone module
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Spare part number

Description

685414-001 Display Hinge Kit (includes left and right display hinges)

685415001 Display enclosure

685416-001 Screw Kit

685417001 Display Cable Kit (includes display panel cable and webcam/microphone cable)

685418-001 Display Screw Kit

685419-001 DVD-ROM Drive

685502001 DVD+RW Double-Layer with SuperMulti Drive

685503-001 Smart Card reader assembly (includes Smart Card reader cable and function LED board cable)

685504-001 12.5 in, HD, LED, AG, SVA display panel

685505-001 Latch Kit (includes battery release latch assembly components and service cover release latch
assembly components)

685506-001 Antenna Kit (includes WLAN antenna cables and transceivers and WWAN antenna cables and
transceivers)

685507-001 Display Panel Support Kit (includes display enclosure with pre-installed WLAN antenna cables and
transceivers and WWAN antenna cables and transceivers)

685508-001 Heat sink (includes replacement thermal material)

685509-001 Function LED board

692857-001 System board for use only on computer models equipped with the Windows 7 operating system in
the People's Republic of China and the Ukraine (includes replacement thermal material)

693710-001 65-W HP Smart AC adapter (PFC, RC/V, EM, 3-wire)

693711-001 65-W HP Smart AC adapter (non-PFC, RC/V, 3-wire)

693716001 65-W HP Travel AC adapter (non-PFC, 3-wire)

694675001 Microphone module

696693-001 Keyboard with pointing stick for use in the United States (includes keyboard cable and pointing
stick cable)

696693-031 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in the United Kingdom and Singapore (includes keyboard cable and pointing
stick cable)

696693-041 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Germany (includes keyboard cable and pointing stick cable)

696693-051 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in France (includes keyboard cable and pointing stick cable)

696693-061 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in ltaly (includes keyboard cable and pointing stick cable)

696693-071 Keyboard with pointing stick for use only on computer models equipped with the Windows 7

operating system in Spain (includes keyboard cable and pointing stick cable)
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Spare part number

Description

696693081 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Denmark (includes keyboard cable and pointing stick cable)

696693091 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Norway (includes keyboard cable and pointing stick cable)

696693-131 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Portugal (includes keyboard cable and pointing stick cable)

696693-141 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Turkey (includes keyboard cable and pointing stick cable)

696693-151 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Greece (includes keyboard cable and pointing stick cable)

696693-161 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Latin America (includes keyboard cable and pointing stick cable)

696693-171 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Saudi Arabia (includes keyboard cable and pointing stick cable)

696693-201 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Brazil (includes keyboard cable and pointing stick cable)

696693-211 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Hungary (includes keyboard cable and pointing stick cable)

696693-251 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Russia (includes keyboard cable and pointing stick cable)

696693-261 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Bulgaria (includes keyboard cable and pointing stick cable)

696693-271 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Romania (includes keyboard cable and pointing stick cable)

696693281 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Thailand (includes keyboard cable and pointing stick cable)

696693291 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Japan (includes keyboard cable and pointing stick cable)

696693-A41 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Belgium (includes keyboard cable and pointing stick cable)

696693-AB1 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Taiwan (includes keyboard cable and pointing stick cable)

696693-AD1 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in South Korea (includes keyboard cable and pointing stick cable)

696693831 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in the Netherlands (includes keyboard cable and pointing stick cable)

696693871 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Sweden and Finland (includes keyboard cable and pointing stick cable)

696693-BA1 Keyboard with pointing stick for use only on computer models equipped with the Windows 7

operating system in Slovenia (includes keyboard cable and pointing stick cable)
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Spare part number

Description

696693-BB1 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Israel (includes keyboard cable and pointing stick cable)

696693-BG1 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Switzerland (includes keyboard cable and pointing stick cable)

696693-D61 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in India (includes keyboard cable and pointing stick cable)

696693-DB1 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Canada (includes keyboard cable and pointing stick cable)

696693-DD1 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Iceland (includes keyboard cable and pointing stick cable)

696693-FL1 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in the Czech Republic and Slovakia (includes keyboard cable and pointing
stick cable)

696693-FP1 Keyboard with pointing stick for use only on computer models equipped with the Windows 7
operating system in Northwest Africa (includes keyboard cable and pointing stick cable)

697057001 128-GB SATA Il solid-state drive

697058001 256-GB SATA Il self-encrypting solid-state drive

697060-001 160-GB SATA Il solid-state drive

700995-001 [q]

180-GB SATA Il solid-state drive

701657-001 [a]

240-GB SATA I solid-state drive

701979-001 [a]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in the United States (includes keyboard cable and pointing stick cable)

701979031 [a]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in the United Kingdom and Singapore (includes keyboard cable and pointing
stick cable)

701979-041 [a]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Germany (includes keyboard cable and pointing stick cable)

701979051 [a]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in France (includes keyboard cable and pointing stick cable)

701979061 [a]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in ltaly (includes keyboard cable and pointing stick cable)

701979071 [a]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Spain (includes keyboard cable and pointing stick cable)

701979-081 [q]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Denmark (includes keyboard cable and pointing stick cable)

701979091 [a]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Norway (includes keyboard cable and pointing stick cable)

701979131 [q]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Portugal (includes keyboard cable and pointing stick cable)

701979-141 [q]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Turkey (includes keyboard cable and pointing stick cable)
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Spare part number

Description

701979-151 [a]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Greece (includes keyboard cable and pointing stick cable)

701979-161 [a]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Latin America (includes keyboard cable and pointing stick cable)

701979-171 [a]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Saudi Arabia (includes keyboard cable and pointing stick cable)

701979-201 [a]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Brazil (includes keyboard cable and pointing stick cable)

701979-211 [a]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Hungary (includes keyboard cable and pointing stick cable)

701979-251 [a]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Russia (includes keyboard cable and pointing stick cable)

701979-261 [a]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Bulgaria (includes keyboard cable and pointing stick cable)

701979-271 [a]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Romania (includes keyboard cable and pointing stick cable)

701979-281 [a]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Thailand (includes keyboard cable and pointing stick cable)

701979291 [a]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Japan (includes keyboard cable and pointing stick cable)

701979-A41 [q]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Belgium (includes keyboard cable and pointing stick cable)

701979-AB1 [a]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Taiwan (includes keyboard cable and pointing stick cable)

701979-AD1 [a]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in South Korea (includes keyboard cable and pointing stick cable)

701979-B31 [d]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in the Netherlands (includes keyboard cable and pointing stick cable)

701979871 [a]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Sweden and Finland (includes keyboard cable and pointing stick cable)

701979-BA1 [q]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Slovenia (includes keyboard cable and pointing stick cable)

701979-BB1 [q]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in the Netherlands (includes keyboard cable and pointing stick cable)

701979-BG1 [q]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Switzerland (includes keyboard cable and pointing stick cable)

701979-D61 [a]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in India (includes keyboard cable and pointing stick cable)

701979-DB1 [a]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Canada (includes keyboard cable and pointing stick cable)

Sequential part number listing
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Spare part number

Description

701979-DD1 [a]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Iceland (includes keyboard cable and pointing stick cable)

701979-FL1 [a]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in the Czech Republic and Slovakia (includes keyboard cable and pointing
stick cable)

701979-FP1 [a]

Keyboard with pointing stick for use only on computer models equipped with the Windows 8
operating system in Northwest Africa (includes keyboard cable and pointing stick cable)

702080-001 [q]

HP un2430 EV-DO/HSPA Mini Card

703148-001 [a]

Service cover (includes label indicating country of origin)

710788-001 [a]

HP hs2350 HSPA+ Mobile Broadband Module

710789001 [a]

HP 12522 LTE/EV-DO Mobile Broadband Module

710790-001 [q]

HP 1t2523 LTE/HSPA+ Mobile Broadband Module
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4 Removal and replacement
procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures:

Flat-bladed screw driver

®  Magnetic screw driver

Phillips PO and P1 screw drivers

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

E‘/fNOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

/\ CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.

Cables and connectors

/\ CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.
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Drive handling

/\ CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the

computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the
operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.
Avoid dropping drives from any height onto any surface.
After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors
or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Grounding guidelines

Electrostatic discharge damage

44

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.
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/\ CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines described

in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by

different activities.

/\ CAUTION: A product can be degraded by as litle as 700 V.

Typical electrostatic voltage levels

Relative humidity

Event 10% 40% 55%
Walking across carpet 35,000 V 15,000 V 7,500V
Walking across vinyl floor 12,000 V 5,000 V 3,000 V
Motions of bench worker 6,000 V 800V 400V
Removing DIPS from plastic tube 2,000V 700V 400V
Removing DIPS from vinyl tray 11,500 V 4,000 vV 2,000V
Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V
Removing bubble pack from PCB 26,500 V 20,000 V 7,000V
Packing PCBs in foam-lined box 21,000V 11,000 V 5,000 V

Preliminary replacement requirements
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.
Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

Place items on a grounded surface before removing items from their containers.

Always be properly grounded when touching a component or assembly.

Store reusable ESD-sensitive parts from assemblies in protective packaging or
nonconductive foam.

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

46

Follow these grounding workstation guidelines:

Cover the workstation with approved static-shielding material.

Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

Use conductive field service tools, such as cutters, screw drivers, and vacuums.

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-
safe materials.

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids
and Styrofoam.

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

Avoid contact with pins, leads, or circuitry.

Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm +10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive must be
worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

Antistatic tape

Antistatic smocks, aprons, and sleeve protectors

Conductive bins and other assembly or soldering aids
Nonconductive foam

Conductive tabletop workstations with ground cords of one megohm resistance
Static-dissipative tables or floor mats with hard ties to the ground
Field service kits

Static awareness labels

Material-handling packages

Nonconductive plastic bags, tubes, or boxes

Metal tote boxes

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level
Antistatic plastics Bags 1,500 V
Carbon-loaded plastic Floor mats 7,500 V
Metallized laminate Floor mats 5,000 V

Preliminary replacement requirements
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Component replacement procedures

This chapter provides removal and replacement procedures.

There are as many as 67 screws that must be removed, replaced, and/or loosened when servicing the
computer. Make special note of each screw size and location during removal and replacement.

Service tag

When ordering parts or requesting information, provide the computer serial number and model number
provided on the service tag. It is necessary to remove the battery to obtain these numbers. See Battery
on page 50 for battery removal instructions.

OO0
©—7 Serial: X0000000C (INITNINANNNNWAINNN

—Produd: JOOOOKXX IIMNMEmNIRNNNIN
—H;J:ijnir 1ylyOy

Item Component Description

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.

(3) Part number/Product number (p/n) This number provides specific information about the
product’s hardware components. The part number helps
a service technician determine what components and
parts are needed.
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Item Component Description

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.

Computer feet

The computer feet are rubber pads that are heatstaked to the base enclosure in the locations
illustrated below.

[
I
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|
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I
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Battery

Description Spare part number
9-cell, 100-Wh, 3.00-Ah 632423-001
6-cell, 62-Wh, 2.80-Ah 632421-001
6-cell, 55-Wh, 2.80-Ah 632419-001
3-cell, 31-Wh, 2.80-Ah 632417-001

Before disassembling the computer, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
3. Disconnect all external devices from the computer.

Remove the battery:

1. Position the computer upside-down on a flat surface, with the battery bay toward you.

2. Slide the battery release latch (1) to release the battery.

3. Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click. The battery release latch
automatically resets when the battery is installed.
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SIM

r__f"%NOTE: This section applies only to computer models with WWAN capability.

[ NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the
computer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 50).

Remove the SIM:
1. Press in on the SIM (1). (The SIM partially ejects from the SIM slot.)
2. Remove the SIM (2) from the SIM slot.

Reverse this procedure to install the SIM.
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Service cover

Description Spare part number
Includes label indicating “Made in China” 685400-001
Includes label indicating country of origin 703148-001

Before removing the service cover, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 50).

Remove the service cover:

1. Position the computer with the battery bay toward you.

2. Slide the release latch (1) and remove the locking screw (if installed) (2).
3. Slide the release latch (3) to disengage the door from the computer.

4. Remove the service cover (4) by lifting it straight up and away from the computer.

Reverse the removal procedures to install the service cover.
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Memory module

E’%NOTE: Primary and expansion memory is installed in a stacked configuration in the bottom of
the computer.

Description Spare part number
8-GB memory module (PC3, 12800, 1600-MHz) 670034-001
4-GB memory module (PC3, 12800, 1600-MHz) 641369-001
2-GB memory module (PC3, 12800, 1600-MHz) 652972-001

Update BIOS before adding memory modules

Before adding new memory, make sure you update the computer to the latest BIOS.

/\ CAUTION: Failure to update the computer to the latest BIOS prior to installing new memory may
result in various system problems.

To update BIOS:

1.
2.
3.

4.
5.
6.
7.
8.

Navigate to www.hp.com.

Click Support & Drivers > click Drivers & Software.

In the Enter a product name/number box, type the computer model information, and then
click Search.

Click the link for the computer model.

Select the operating system, and then click Next.

Under Step 2: Select a Download, click the BIOS link.
Click the link for the most recent BIOS.

Click the Download button, and then follow the on-screen instructions.

Before removing a memory module, follow these steps:

1.

2.
3.
4.
5.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.
Disconnect all external devices from the computer.

Remove the battery (see Battery on page 50).

Remove the service cover (see Service cover on page 52).

Remove the memory module:

1.

Spread the retaining tabs (1) on each side of the memory module slot to release the
memory module. (The edge of the module opposite the slot rises away from the computer.)
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2. Remove the memory module (2) by pulling the module away from the slot at an angle.

E’%NOTE: The computer uses two memory slots. The top slot houses the expansion memory module.
The bottom slot houses the primary memory module.

Reverse this procedure to install @ memory module.

Bluetooth module

E/?’NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kit, spare part number 693306-001.

Description Spare part number

Bluetooth module 655792-001

Before removing a Bluetooth module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.

Remove the battery (see Battery on page 50).

2
3. Disconnect all external devices from the computer.
4
5

Remove the service cover (see Service cover on page 52).
Remove the Bluetooth module:

1. Disconnect the Bluetooth module cable (1) from the system board.
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2. Release the Bluetooth module cable (2) from the clip and routing channel built into the
speaker assembly.

3. Lift and rotate the front edge of the Bluetooth module (1) until it disengages from the clip built into
the speaker assembly.

4. Disconnect the Bluetooth module cable (2) from the Bluetooth module.

5. Remove the Bluetooth module (3).

Reverse this procedure to install a memory module.
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Speaker assembly

Description Spare part number

Speaker assembly (includes cable) 651377001

Before removing the speaker assembly, follow these steps:

1.

S T o

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.
Disconnect all external devices from the computer.

Remove the battery (see Battery on page 50), and then remove the following components:

Remove the service cover (see Service cover on page 52).

Remove the Bluetooth module (see Bluetooth module on page 54)

Remove the speaker assembly:

1.
2,

Disconnect the speaker assembly cable (1) from the system board.

Remove the Phillips PM2.0x3.6 screw (2) and the two Phillips PM2.0x7.7 screws (3) that secure
the speaker assembly to the base enclosure.

Remove the speaker assembly (4).
(3]
e ¥

1
1
1
|
0
0
0
0
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Reverse this procedure to install the speaker assembly.
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Optical drive

E"%NOTE: The optical drive spare part kit includes the optical drive bezel and optical drive bracket.

Description Spare part number
DVD+RW Double-Layer with SuperMulti Drive 685502001
DVD-ROM Drive 685419-001

Before removing the optical drive, follow these steps:

1.

0

O A O DN

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.
Disconnect all external devices from the computer.

Remove the battery (see Battery on page 50), and then remove the following components:

Remove the service cover (see Service cover on page 52).

Remove the optical drive:

1.

Position the computer upside-down with the right side toward you.
Loosen the captive Phillips screw (1) that secures the optical drive to the computer.

Use a flat-blade screw driver or similar tool to press on the optical drive bracket tab (2) to release
the optical drive.

Remove the optical drive (3) from the computer.

Reverse this procedure to install the optical drive.
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Hard drive

@NOTE: The hard drive spare part kit does not include the hard drive bracket or screws.

Description Spare part number
750-GB, 7200-rpm, 9.5-mm 633252-001
500-GB, 7200-rpm, 9.5-mm SED 683801-001
500-GB, 7200-rpm, 9.5-mm 634925-001
320-GB, 7200-rpm, 9.5-mm 634862-001

Hard Drive Hardware Kit (includes hard drive bracket, hard drive connector adapter, and screws)  651380-001

Before removing the hard drive, follow these steps:

1.

2
3.
4
5

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.

Disconnect all external devices from the computer.

Remove the battery (see Battery on page 50).

Remove the service cover (see Service cover on page 52).

Remove the hard drive:

1.
2.

Loosen the four captive Phillips screws (1) that secure the hard drive to the computer.

Use the hard drive tab (2) to slide the hard drive toward the front of the computer and disconnect
it from the system board.
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3. Remove the hard drive (3) by lifting it straight up and away from the computer.

4. Ifitis necessary to disassemble the hard drive, perform the following steps:
a. Position the hard drive with the connector toward you.
b. Disconnect the hard drive connector adapter (1) from the hard drive.

c. Remove the four Phillips PM3.0x3.3 screws (2) that secure the hard drive bracket to the
hard drive.

d. Remove the hard drive bracket (3) from the hard drive.

The hard drive bracket, hard drive connector adapter, and screws are available in the Hard
Drive Hardware Kit, spare part number 651380-001.
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Reverse this procedure to reassemble and install the hard drive.

Fan

Description Spare part number

Fan (includes cable) 651378-001

Before removing the fan, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.

Remove the battery (see Battery on page 50).

2,
3. Disconnect all external devices from the computer.
4.
5.

Remove the service cover (see Service cover on page 52).

Remove the fan:
1. Disconnect the fan cable (1) from the system board.

2. Lloosen the two captive screws (2) that secure the fan to the top cover.
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3. Remove the fan (3).

Reverse this procedure to install the fan.

WWAN module

E‘/fNOTE: The WWAN module and the WLAN module are not interchangeable.

Description Spare part number
HP hs2350 HSPA+ Mobile Broadband Module 710788-001
HP 1t2523 LTE/HSPA+ Mobile Broadband Module 710790-001
HP 112522 LTE/EV-DO Mobile Broadband Module 710789-001
HP un2430 EV-DO/HSPA Mini Card 702080-001
HP un2430 EV-DO/HSPA Mobile Broadband Module 634400-001

Before removing the WWAN module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.
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4. Remove the battery (see Battery on page 50).

5. Remove the service cover (see Service cover on page 52).

Remove the WWAN module:

1. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

E"%NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal.
The blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.
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2. Remove the two Phillips PM2.0x3.0 screw (2) that secures the WWAN module to the
base enclosure. (The WWAN module tilts up.)
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3. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

A _
, / ot

@NOTE: If the WWAN antenna cables are not connected to the terminals on the WWAN module, the

protective sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WWAN module.
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WLAN module

Description Spare part number
Atheros WB225 1x1 802.11b/g/n Bluetooth Combo Adapter 675794-001
Broadcom 43228 802.11abgn 2x2 Wi-Fi Adapter 669832001
Intel Centrino Advanced-N 6205 WLAN module 631954001

/\ CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore device functionality, and then contact technical support.

Before removing the WLAN module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.

. Disconnect all external devices from the computer.

Remove the battery (see Battery on page 50).

Remove the service cover (see Service cover on page 52).

o U A~ W DN

Remove the WWAN module (see WWAN module on page 61).
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Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

E‘/f'NOTE: The WLAN antenna cable labeled “1” connects to the WLAN module “Main” terminal
labeled “1”. The WLAN antenna cable labeled “2” connects to the WLAN module “Aux” terminal
labeled “2”. If the computer is equipped with an 802.11a/b/g/n WLAN module, the yellow
WILAN antenna cable connects to the middle terminal on the WLAN module.
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2. Remove the two Phillips PM2.0x3.0 screws (2) that secure the WLAN module to the
base enclosure. (The WLAN module tilts up.)
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@NOTE: If the WLAN antenna cables are not connected to the terminals on the WLAN module, the
protective sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WLAN module.

Modem module

@NOTE: The modem module does not include a modem module cable. The modem module cable is
included in the Cable Kit, spare part number 651384-001.

Description Spare part number

Modem module (56k v.92 MDC data/fax) 628824-001

Before removing the modem module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.

Disconnect all external devices from the computer.

2
3
4. Remove the battery (see Battery on page 50).
5

Remove the service cover (see Service cover on page 52).
Remove the modem module:
1. Remove the Phillips PM2.0x3.6 screw (1) that secures the modem module to the system board.

2. lift the modem module (2) straight up to disconnect it from the system board.
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3. Disconnect the RJ-11 cable (3) from the modem module.

4. Remove the modem module.

Reverse this procedure to install the modem module.

Keyboard

E’%NOTE: The keyboard spare part kit includes a pointing stick, keyboard cable, and pointing stick

cable.

For use in country/region Spare part For use in country/region Spare part
number number

For use only on computer models equipped with the Windows  For use in the Netherlands 701979831
8 Standard and Professional operating system:
For use in Belgium 701979-A41 For use in Norway 701979-091
For use in Brazil 701979-201 For use in Northwest Africa 701979-FP1
For use in Bulgaria 701979-261 For use in Portugal 701979-131
For use in Canada 701979-DB1 For use in Romania 701979-271
For use in the Czech Republic and 701979FL1 For use in Russia 701979251
Slovakia
For use in Denmark 701979081 For use in Saudi Arabia 701979171
For use in France 701979-051 For use in Slovenia 701979-BA1
For use in Germany 701979-041 For use in South Korea 701979-AD1
For use in Greece 701979-151 For use in Spain 701979-071
For use in Hungary 701979211 For use in Sweden and Finland 701979871
For use in Iceland 701979-DD1 For use in Switzerland 701979-BG1
For use in India 701979-D61 For use in Taiwan 701979-AB1
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For use in country/region Spare part For use in country/region Spare part

number number
For use in Israel 701979-BB1 For use in Thailand 701979-281
For use in ltaly 701979-061 For use in Turkey 701979-141
For use in Japan 701979291 For use in the United Kingdom and 701979031
Singapore

For use in Latin America 701979-161 For use in the United States 701979001
For use only on computer models equipped with the Windows  For use in the Netherlands 696693-B31
7 operating system:

For use in Belgium 696693-A41 For use in Norway 696693-091
For use in Brazil 693362-201 For use in Northwest Africa 696693-FP1
For use in Bulgaria 696693261 For use in Portugal 696693-131
For use in Canada 696693-DB1 For use in Romania 696693-271
For use in the Czech Republic 696693-FL1 For use in Russia 696693-251
and Slovakia

For use in Denmark 696693081 For use in Saudi Arabia 696693-171
For use in France 696693-051 For use in Slovenia 696693-BA1
For use in Germany 696693-041 For use in South Korea 696693-AD1
For use in Greece 696693-151 For use in Spain 696693-071
For use in Hungary 696693211 For use in Sweden and Finland 696693871
For use in Iceland 696693-DD1 For use in Switzerland 696693-BG1
For use in India 696693-D61 For use in Taiwan 696693-AB1
For use in Israel 696693-BB1 For use in Thailand 696693-281
For use in Italy 696693-061 For use in Turkey 696693-141
For use in Japan 696693-291 For use in the United Kingdom 696693-031

and Singapore

For use in Latin America 696693-161 For use in the United States 696693-001

Before removing the keyboard, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 50).
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5. Remove the service cover (see Service cover on page 52).

6. Remove the fan (see Fan on page 60).

Remove the keyboard:

1. Loosen the three Phillips captive screws that secure the keyboard to the computer.

2. Rest and secure the computer on its left side.
3. Partially open the computer.

4. Insert a screw driver or similar thin tool into the keyboard release opening in the fan opening, and
then press on the back of the keyboard until the keyboard disengages from the computer.

5. Turn the computer rightside up with the front toward you.
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6. Open the computer.

7. Lift the rear edge of the keyboard until the keyboard rests at an angle, and then swing the top
edge of the keyboard up and forward (1) until it rests upside down on the palm rest.

8. Release the zero insertion force (ZIF) connector (2) to which the pointing stick cable is attached,
and then disconnect the pointing stick cable (3) from the system board.

9. Release the ZIF connector (4) to which the keyboard cable is attached, and then disconnect the
keyboard cable (5) from the system board.

10. Remove the keyboard (6).

Reverse this procedure to install the keyboard.

RTC battery

Description Spare part number

RTC battery (includes cable and double-sided adhesive) 665733-001

Before removing the RTC battery, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
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3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 50), and then remove the following components:

a. Service cover (see Service cover on page 52)

b. Fan (see Fan on page 60)

c. Keyboard (see Keyboard on page 69)

Remove the RTC battery:
1. Disconnect the RTC battery cable (1) from the system board.

2. Detach the RTC battery (2) from the system board. (The RTC battery is attached to the system
board with double-sided adhesive.)

3. Remove the RTC battery.

Reverse this procedure to install the RTC battery.
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Base enclosure

74

Description Spare part number

Base enclosure (includes 4 rubber feet, battery release latch assembly, service cover release latch ~ 685403-001

assembly, and replacement thermal material)

Before removing the base enclosure, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 50), and then remove the following components:

b.

Service cover (see Service cover on page 52)

Bluetooth module (see Bluetooth module on page 54)

Speaker assembly (see Speaker assembly on page 56)

Optical drive (see Optical drive on page 57)

Hard drive (see Hard drive on page 58)

Fan (see Fan on page 60)

WWAN module (see WWAN module on page 61)

Modem module (see Modem module on page 68)

Keyboard (see Keyboard on page 69)
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Remove the base enclosure:

1. Release the ZIF connectors to which the following cables are attached, and then disconnect the
corresponding cables from the system board:

(1) Power button board cable
(2) Fingerprint reader board cable
(3) Function board cable

2. Close the computer.

3. Turn the computer upside down, with the battery bay toward you.

Component replacement procedures 75



4. Remove the four Torx TM2.5x8.0 screws that secure the base enclosure to the computer.

5. Remove the three rubber screw covers in the front corners (1) and the right side (2) of the

base enclosure. The rubber screw covers are included in the Rubber Kit, spare part number
651382-001.

6. Remove the five Torx TM2.5x8.0 screws (3) that secure the base enclosure to the computer.

L
I
1
I
I
I
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7. Remove the following screws that secure the base enclosure to the computer:

(1) Three Phillips PM2.0x7.6 screws (two on the front edge of the computer and one in the middle
of the computer)

(2) Two Phillips PM2.0x3.6 screws in the optical drive bay
(3) Three Phillips PM2.0x3.6 screws in the battery bay

L]
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8. Lift the rear edge of the base enclosure (1), and then swing the base enclosure up and forward
until the base enclosure detaches from the computer.
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9. Remove the base enclosure (2) from the computer.

10. Remove the base enclosure.

r__f"%NOTE: When replacing the base enclosure, thoroughly clean the thermal pad material from the
surfaces of the PCH chip (1) and the base enclosure (2). All base enclosure and system board
spare part kits include replacement thermal pad material.

Reverse this procedure to install the base enclosure.
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System board

E’%NOTE: The system board spare part kit includes replacement thermal material.

Description Spare part number

For use only on computer models equipped with the Windows 8 Professional operating system in ~ 685404-601
all countries and regions except the People's Republic of China and the Ukraine

For use only on computer models equipped with the Windows 8 Standard operating system in all ~ 685404-501
countries and regions except the People's Republic of China and the Ukraine

For use only on computer models equipped with the Windows 7 operating system in all countries ~ 685404-001
and regions except the People's Republic of China and the Ukraine

For use only on computer models equipped with the Windows 7 operating system in the People's ~ 692857-001
Republic of China and the Ukraine

Before removing the system board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 50), and then remove the following components:

a. Service cover (see Service cover on page 52)

b. Bluetooth module (see Bluetooth module on page 54)

c. Speaker assembly (see Speaker assembly on page 56)

d. Optical drive (see Optical drive on page 57)

e. Hard drive (see Hard drive on page 58)

f. Fan (see Fan on page 60)
g. WWAN module (see WWAN module on page 61)
h. Modem module (see Modem module on page 68)

Keyboard (see Keyboard on page 69)

j- Base enclosure (see Base enclosure on page 74)

E‘/f'NOTE: When replacing the system board, be sure that the following components are removed from
the defective system board and installed on the replacement system board:

e  SIM (see SIM on page 51)

®  Memory module (see Memory module on page 53)
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WLAN module (see WLAN module on page 65)
RTC battery (see RTC battery on page 72)

Heat sink (see Heat sink on page 81)

Processor (see Processor on page 84)

Remove the system board:

1.
2,

6.
7.

Remove the ExpressCard slot space saver (1).

Release the ZIF connector (2) to which the Smart Card reader assembly cable is connected, and
then disconnect the Smart Card reader assembly cable (3) from the system board.

Release the tape (4) that secures the display panel cable to the system board, and then disconnect
the display panel cable (5) from the system board.

Release the display panel cable from the clip (6) built into the right display hinge.

Release the wireless antenna cables from the retention clip (7) attached to the system board.

Remove the Phillips PM2.0x3.6 screw (1) that secures the system board to the top cover.

Lift the left side of the system board (2) until it rests at an angle.
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8. Remove the system board (3) by sliding it up and to the left at an angle.

9. Remove the system board.

Reverse this procedure fo install the system board.

Heat sink
Description Spare part number
Heat sink (includes replacement thermal material) 685508-001

Before removing the heat sink, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 50), and then remove the following components:

a. Service cover (see Service cover on page 52)

b. Bluetooth module (see Bluetooth module on page 54)

c. Speaker assembly (see Speaker assembly on page 56)

d. Optical drive (see Optical drive on page 57)

e. Hard drive (see Hard drive on page 58)

f. Fan (see Fan on page 60)
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WWAN module (see WWAN module on page 61)

h. Modem module (see Modem module on page 68)

i. Keyboard (see Keyboard on page 69)

j- Base enclosure (see Base enclosure on page 74)

k. System board (see System board on page 79)

Remove the heat sink:

1. Following the 1, 2, 3, 4 sequence stamped into the heat sink, loosen the four captive Philllips
screws (1) that secure the heat sink to the system board.
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2.

Remove the heat sink (2).

B NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
the system board components, it may be necessary to move the heat sink from side to side to

detach it.

— — i ]

Eﬁ’NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink and
the system board components each time the heat sink is removed. Replacement thermal material is
included with the heat sink and system board spare part kits. Thermal paste is used on the
processor (1) and the heat sink section (2) that services it.
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Reverse this procedure to install the heat sink.

Processor

84

Description Spare part number

Intel Dual Core i7-3520M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz FSB, 4.0- 681954-001
MB L3 cache, 35 W)

Intel Dual Core i5-3360M 2.80-GHz processor (SC turbo up to 3.50-GHz; 1600-MHz FSB, 3.0- 681953-001
MB L3 cache, 35 W)

Intel Dual Core i5-3320M 2.60-GHz processor (SC turbo up to 3.30-GHz; 1600-MHz FSB, 3.0- 681952-001
MB L3 cache, 35 W)

Intel Dual Core i5-3210M 2.50-GHz processor (SC turbo up to 3.10-GHz; 1600-MHz FSB, 3.0-  680645-001
MB L3 cache, 35 W)

Intel Core i3-3110M 2.40-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W) 682417-001

Before removing the processor, follow these steps:

1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.

Disconnect all external devices from the computer.

Remove the battery (see Battery on page 50), and then remove the following components:

a.
b.
c.

d.

Service cover (see Service cover on page 52)

Bluetooth module (see Bluetooth module on page 54)

Speaker assembly (see Speaker assembly on page 56)

Optical drive (see Optical drive on page 57)

Hard drive (see Hard drive on page 58)

Fan (see Fan on page 60)

WWAN module (see WWAN module on page 61)

Modem module (see Modem module on page 68)

Keyboard (see Keyboard on page 69)

Base enclosure (see Base enclosure on page 74)

System board (see System board on page 79)

Heat sink (see Heat sink on page 81)

Chapter 4 Removal and replacement procedures



Remove the processor:

1. Use a flatbladed screw driver (1) to turn the processor locking screw one-half turn
counterclockwise, until you hear a click.

2. Lift the processor (2) straight up, and remove it.

@NOTE: The gold triangle (3) on the processor must be aligned with the triangle icon (4)
embossed on the processor socket when you install the processor.

B
l'”j,.r T

Reverse this procedure to install the processor.
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Fingerprint reader board

86

Description Spare part number

Fingerprint reader board (includes bracket and cable) 685410001

Before removing the fingerprint reader board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 50), and then remove the following components:

b.

Service cover (see Service cover on page 52)

Bluetooth module (see Bluetooth module on page 54)

Speaker assembly (see Speaker assembly on page 56)

Optical drive (see Optical drive on page 57)

Hard drive (see Hard drive on page 58)

Fan (see Fan on page 60)

WWAN module (see WWAN module on page 61)

Modem module (see Modem module on page 68)

Keyboard (see Keyboard on page 69)

Base enclosure (see Base enclosure on page 74)

Remove the fingerprint reader board:

1. Remove the Phillips PM2.0x3.6 screw (1) that secures the fingerprint reader board bracket to the
top cover.

2. Remove the fingerprint reader board bracket (2).

Chapter 4 Removal and replacement procedures



3. Remove the fingerprint reader board and cable (3).
I
|

(2

- AT
Reverse this procedure to install the fingerprint reader board.

Top cover

E’%NOTE: The top cover spare part kit includes the TouchPad and TouchPad cable. The TouchPad cable
is also available in the Cable Kit, spare part number 651384-001.

Description Spare part number
For use on computer models equipped with a fingerprint reader 685407001
For use on computer models not equipped with a fingerprint reader 685406-001

Before removing the top cover, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 50), and then remove the following components:

a. Service cover (see Service cover on page 52)

b. Bluetooth module (see Bluetooth module on page 54)
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c. Speaker assembly (see Speaker assembly on page 56)

d. Optical drive (see Optical drive on page 57)

e. Hard drive (see Hard drive on page 58)

f. Fan (see Fan on page 60)

WWAN module (see WWAN module on page 61)

h. Modem module (see Modem module on page 68)

i. Keyboard (see Keyboard on page 69)

j- Base enclosure (see Base enclosure on page 74)

k. System board (see System board on page 79)

991

NOTE: When replacing the top cover, be sure that the following components are removed from the
defective top cover and installed on the replacement top cover:

®  Fingerprint reader board (see Fingerprint reader board on page 86)

®  Function button board (see Function button board on page 89)

e  Power button board (see Power button board on page 91)

e  Smart Card reader assembly (see Smart Card reader assembly on page 92)

Remove the top cover:

1. Release the wireless antenna cables (1) from the routing channels (2) built into the top cover.

Y v o L
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2. Remove the two Phillips PM2.0x7.6 screws (1) that secure the display assembly to the top cover.
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3. Swing the display hinges (2) up and back until the top cover is free for removal.
4. Slide the top cover forward (3).

5. Remove the top cover (4).

Reverse this procedure to install the top cover.

Function button board

Description Spare part number

Function button board (includes cable) 685409-001

Before removing the function button board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 50), and then remove the following components:

a. Service cover (see Service cover on page 52)

b. Bluetooth module (see Bluetooth module on page 54)

c. Speaker assembly (see Speaker assembly on page 56)
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d. Optical drive (see Optical drive on page 57)

e. Hard drive (see Hard drive on page 58)

f. Fan (see Fan on page 60)

WWAN module (see WWAN module on page 61)

= @

Modem module (see Modem module on page 68)

Keyboard (see Keyboard on page 69)

j- Base enclosure (see Base enclosure on page 74)

k. System board (see System board on page 79)

l.  Top cover (see Top cover on page 87)

Remove the function button board:
1. Position the top cover with the top edge toward you.

2. Press down on the bottom edge (1) of the refention bracket, and then slide the top edge of the
bracket (2) out of the top cover.

E%NOTE: The retention bracket is included in the Bracket Kit, spare part number 651381-001.

3. Remove the Phillips PM2.0x3.6 screw (3) that secures the function button board to the top cover.

4. Remove the function button board (4) and cable.

Reverse this procedure to install the function button board.
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Power button board

Description Spare part number

Power button board (includes cable) 685408-001

Before removing the power button board, follow these steps:

1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.
Disconnect all external devices from the computer.

Remove the battery (see Battery on page 50), and then remove the following components:

a. Service cover (see Service cover on page 52)

b. Bluetooth module (see Bluetooth module on page 54)

c. Speaker assembly (see Speaker assembly on page 56)

d. Optical drive (see Optical drive on page 57)

e. Hard drive (see Hard drive on page 58)

f. Fan (see Fan on page 60)

g. WWAN module (see WWAN module on page 61)
h. Modem module (see Modem module on page 68)

Keyboard (see Keyboard on page 69)

j- Base enclosure (see Base enclosure on page 74)

k. System board (see System board on page 79)

I.  Top cover (see Top cover on page 87)

Remove the power button board:

1.

2
3.
4

Position the top cover with the top edge toward you.

Release the tape (1) the secures the power button board cable to the top cover.

Remove the Phillips PM2.0x3.6 screw (2) that secures the power button board to the top cover.

Lift the left side of the power button board (3) until it rests at an angle.
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5. Remove the power button board (4) and cable by sliding it up and to the left at an angle.

Reverse this procedure to install the power button board.

Smart Card reader assembly

92

Description Spare part number

Smart Card reader assembly (includes Smart Card reader cable and function LED board cable) 685503-001

Before removing the Smart Card reader assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 50), and then remove the following components:

a.
b.
c.

d.

e.

Service cover (see Service cover on page 52)

Bluetooth module (see Bluetooth module on page 54)

Speaker assembly (see Speaker assembly on page 56)

Optical drive (see Optical drive on page 57)

Hard drive (see Hard drive on page 58)
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Fan (see Fan on page 60)

WWAN module (see WWAN module on page 61)

T @

Modem module (see Modem module on page 68)

Keyboard (see Keyboard on page 69)

j- Base enclosure (see Base enclosure on page 74)

k. System board (see System board on page 79)

l.  Top cover (see Top cover on page 87)

Remove the Smart Card reader assembly:
1. Release the function LED board (1) from the clips built into the top cover.

2. Release the ZIF connectors to which the TouchPad board cables are connected, and then
disconnect the TouchPad cables (2) and (3) from the Smart Card reader assembly.

3. Release the Smart Card reader assembly cable (4) from the clips (5) built into the top cover.

4. Remove the Phillips PM2.0x2.5 broad head screw (1) that secures the Smart Card reader
assembly to the top cover.
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5. Slide the Smart Card reader assembly (2) to the right to release it from the clips built into the
top cover, and then remove the Smart Card reader assembly (3).

6. Ifitis necessary to replace the function LED board, release the ZIF connector to which the function
LED board cable is connected, and then disconnect the function LED board cable (1) from the
function LED board.

7. Remove the function LED board (2).
The function LED board is available using spare part number 685509-001.

fo

Reverse this procedure to install the Smart Card reader assembly and function LED board.
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Display assembly subcomponents

E’%NOTE: The display assembly is spared at the subcomponent level only. For more display assembly
spare part information, see the individual removal subsections.

To access the display assembly subcomponents, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 50), and then remove the following components:

a. Service cover (see Service cover on page 52)

b. Bluetooth module (see Bluetooth module on page 54)

c. Speaker assembly (see Speaker assembly on page 56)

d. Optical drive (see Optical drive on page 57)

e. Hard drive (see Hard drive on page 58)

f. Fan (see Fan on page 60)
g. WWAN module (see WWAN module on page 61)
h. Modem module (see Modem module on page 68)

Keyboard (see Keyboard on page 69)

-
.

j- Base enclosure (see Base enclosure on page 74)

k. System board (see System board on page 79)

l.  Top cover (see Top cover on page 87)

1. [Ifitis necessary to replace the display bezel or any of the display assembly subcomponents:

a. Flex the inside edges of the bottom edge (1), the left and right sides (2), and the
top edge (3) of the display bezel until the bezel disengages from the display enclosure.
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b. Remove the display bezel (4).

The display bezel is available using spare part numbers 685411-001 (for use on computer
models equipped with a webcam) and 685412-001 (for use on computer models not
equipped with a webcam).
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2. Ifitis necessary to replace the display panel:

a. Remove the four Phillips PM2.5x5.0 screws (1) and the two Phillips PM2.0x2.5 screws (2)
that secure the display panel to the display enclosure.
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b. Lift the top edge of the display panel and swing it up and forward until it rests at an angle.

c. Release the adhesive support strip (1) that secures the display panel cable to the
display panel.

d. Detach the display panel cable (2) from the surface of display panel. (The display panel
cable is attached to the display panel with double-side adhesive.)

Component replacement procedures 97



e. Disconnect the display panel cable (3) from the display panel.

f. Remove the four Phillips PM2.0x3.6 screws (1) that secure the display panel to the display
hinge brackets.

g. Remove the display panel (2).
The display panel is available using spare part number 685504-001.
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3. [Ifitis necessary fo replace the webcam/microphone module:

/\ CAUTION: Handle the webcam/microphone module and microphone module with caution.
These modules have a thin profile and are susceptible to damage when not handled carefully.

a. Remove the webcam/microphone module shield (1) from the webcam/microphone module
and display enclosure. (The webcam/microphone module shield is attached to the webcam/
microphone module and display enclosure with double-sided tape.)

b. Disconnect the webcam/microphone module cable (2) from the webcam/
microphone module.

c. Remove the webcam/microphone module (3).

The webcam/microphone module is available using spare part number 685413-001. The
microphone module is available using spare part number 694675-001.

4. Ifitis necessary to replace the display hinges, display hinge covers, and/or display hinge caps:
a. Remove the display hinge caps (1) from the display hinges.

b. Remove the two Phillips PM2.0x3.6 screws (2) that secure the display hinge covers to the
display hinges.

Component replacement procedures 99



c. Remove the display hinge covers (3) from the display hinges.
The display hinges are included in the Display Hinge Kit, spare part number 685414-001.

The display hinge covers and display hinge caps are included in the Display Hinge Cover
Kit, spare part number 685405-001.

o
&
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5. Ifitis necessary to replace the display clutch cover:

a. Remove the three Phillips PM2.0x3.6 screws (1) that secure the display clutch cover to the
display enclosure.

b. Release the display clutch cover (2) from the display enclosure.
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c. Release the wireless antenna cables (3) and display panel cable (4) from the display clutch
cover, making note of the locations of the display cable guides (5) at the left and right ends
of the display clutch cover.

d. Remove the display clutch cover.

The display clutch cover is included in the Display Hinge Cover Kit, spare part number
685405-001.

6. [Ifitis necessary fo replace the display panel cable:
a. Disconnect the display panel cable (1) from the webcam/microphone module.

b. Detach the display panel cable (2) from the surface of display enclosure. (The display panel
cable is attached to the display enclosure with double-side adhesive.)
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c. Remove the display panel cable (3).

The display panel cable is included in the Display Cable Kit, spare part number
685417-001.

7. Ifitis necessary to replace the WLAN antenna cables and transceivers:

a. Detach the WLAN antenna transceivers (1) from the display enclosure. (The WLAN antenna
transceivers are attached to the display enclosure with double-sided tape.)

b. Release the WLAN antenna cables from the clips (2) and routing channels built into the
display enclosure.
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¢. Remove the WLAN antenna cables and transceivers (3). The WLAN antenna cables and
transceivers are included in the Antenna Kit, spare part number 685506-001.

of

te

8. [Ifitis necessary to replace the WWAN antenna cables and transceivers:

a. Detach the WWAN antenna transceivers (1) from the display enclosure. (The WWAN
antenna transceivers are attached to the display enclosure with double-sided tape.)

b. Release the WWAN antenna cables from the clips (2) and routing channels built into the
display enclosure.
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c. Remove the WWAN antenna cables and transceivers (3). The WWAN antenna cables and
transceivers are included in the Antenna Kit, spare part number 685506-001.

TRN! .:'!Hl:
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TN
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#

Reverse this procedure to reassemble and install the display assembly.
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5 Computer Setup (BIOS) and
Advanced System Diagnostics

Windows 8

Using Computer Setup

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of devices installed, the startup sequence of the
computer, and the amount of system and extended memory.

E’%NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup

r__f'%NOTE: An external keyboard or mouse connected to a USB port can be used with Computer
Setup only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

4

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu
message is displayed at the bottom of the screen.

2. Press {10 to enter Computer Setup.
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Navigating and selecting in Computer Setup
To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

e  To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press entfer, or use a pointing device to click the item.

e To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

e  To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

@NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or
the keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

To exit Computer Setup menus, choose one of the following methods:

e  To exit Computer Setup menus without saving your changes:
Click the Exit icon in the lower-left corner of the screen, and then follow the on-screen instructions.
—or—

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

e To save your changes and exit Computer Setup menus:

Click the Save icon in the lower-left corner of the screen, and then follow the on-screen
instructions.

—or —

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then
press enter.

Your changes go into effect when the computer restarts.
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Restoring factory settings in Computer Setup

[ NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press f10 to enter Computer Setup.
Use a pointing device or the arrow keys to select File > Restore Defaults.

Follow the on-screen instructions.

o S

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

E‘jNOTE: Your password settings and security settings are not changed when you restore the
factory seftings.

Updating the BIOS

Updated versions of the BIOS may be available on the HP website.
Most BIOS updates on the HP website are packaged in compressed files called SoftPags.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn
+esc (if you are already in Windows) or by using Computer Setup.

1. Start Computer Setup.
2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

—or —

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.
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Downloading a BIOS update

/\ CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the AC
adapter. Do not download or install a BIOS update while the computer is running on battery power,
docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. From the Start screen, type h, and then select Help and Support.

2. Inthe Help and Support search box, type maintain, and then follow the on-screen
instructions to identify your computer and access the BIOS update you want to download.

3. At the download areq, follow these steps:

a. Identify the BIOS update that is later than the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information
to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

Make a note of the path to the location on your hard drive where the BIOS update is
downloaded. You will need to access this path when you are ready to install the update.

@NOTE: If you connect your computer to a network, consult the network administrator before
installing any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:

1. From the Start screen, type e, and then click File Explorer.
2. Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4. Doubleclick the file that has an .exe extension (for example, filename.exe).
The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

@NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.
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Using Advanced System Diagnostics

Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware
is functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:

e  System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests
on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

e  Startup test—This test analyzes the main computer components that are required to start
the computer.

®  Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

®  Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

®  Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

e  Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.
If the battery fails the test, contact HP support to report the issue and purchase a
replacement battery.

e  BIOS Management—You can update or rollback the version of the BIOS on the system. Do not
shut down or remove external power during the process. You will be given a confirmation screen
before your BIOS is modified. Select BIOS update, BIOS Rollback, or Back to
main menu.

You can view system information and error logs or select languages in the Advanced System
Diagnostics window.

To start Advanced System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press 2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

E’jNOTE: NOTE: you need to stop a diagnostics test while it is running, press esc.
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Windows 7

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of peripherals installed, the startup sequence of the
computer, and the amount of system and extended memory.

@NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup

@NOTE: An external keyboard or mouse connected to a USB port can be used with Computer
Setup only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press {10 to enter Computer Setup.

Using Computer Setup

Navigating and selecting in Computer Setup
To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

e To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press entfer, or use a pointing device to click the item.

e  To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

e  To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

E%NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or
the keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.
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To exit Computer Setup menus, choose one of the following methods:

® To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

—or —

e To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

—Oor —

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then
press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

E’%NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press f10 to enter Computer Setup.
Use a pointing device or the arrow keys to select File > Restore Defaults.

Follow the on-screen instructions.

L S

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

E’/f’NOTE: Your password settings and security settings are not changed when you restore the
factory seftings.
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Updating the BIOS

Updated versions of the BIOS may be available on the HP Web site.
Most BIOS updates on the HP Web site are packaged in compressed files called SoftPags.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed as follows:
1. Start Computer Setup.
2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

—or —

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enfer.

@NOTE: You can also determine the BIOS version by turning on or restarting the computer, pressing
the esc key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the
screen, and then pressing the 1 key. Follow the on-screen instructions to exit this screen.

Downloading a BIOS update

/\ CAUTION: CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation,
download and install a BIOS update only when the computer is connected to reliable external power
using the AC adapter. Do not download or install a BIOS update while the computer is running on
battery power, docked in an optional docking device, or connected to an optional power source.
During the download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Suspend or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Open your Web browser. For U.S. support, go to hitp://www.hp.com/go/contactHP.
For worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact us.html.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want
to download.
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3. Click the option for software and driver downloads, type your computer model number in the
product box, and then press enter. Follow the on-screen instructions to identify your computer and
access the BIOS update you want to download.

Click your specific product from the models listed.

Click the appropriate operating system.

o o &

Go to the BIOS section and download the BIOS software package.

7. Follow the installation instructions as provided with the downloaded BIOS software package.

E’%NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.

Using Advanced System Diagnostics

Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware
is functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:

e  Start-up test—This test analyzes the main computer components that are required to start
the computer.

®  Run-in test—This fest repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

e  Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

®  Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

®  Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.
If the battery fails the test, contact support to report the issue and purchase a replacement battery.

e  System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests
on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

You can view system information and error logs in the Advanced System Diagnostics window.
To start Advanced System Diagnostics:

1. 1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press {2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

E’/fNOTE: If you need to stop a diagnostics test while it is running, press esc.
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SuUSE Linux (SLED)

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of peripherals installed, the startup sequence of the
computer, and the amount of system and extended memory.

@NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup

@NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press {10 to enter Computer Setup.

Using Computer Setup

Navigating and selecting in Computer Setup
To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

e To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press entfer, or use a pointing device to click the item.

e  To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

e  To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

E‘jNOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.
To exit Computer Setup menus, choose one of the following methods:

e  To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

—or —

114 Chapter 5 Computer Setup (BIOS) and Advanced System Diagnostics



Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

—Oor —

® To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

[Bf NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press 10 to enter Computer Setup.
Use a pointing device or the arrow keys to select File > Restore Defaults.

Follow the on-screen instructions.

o S A

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

E’%’NOTE: Your password settings and security settings are not changed when you restore the factory
seftings.

Updating the BIOS

Updated versions of the BIOS may be available on the HP Web site.
Most BIOS updates on the HP Web site are packaged in compressed files called SoftPags.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.
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Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed as follows:
1. Start Computer Setup.
2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

—or —

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

B NOTE:  You can also determine the BIOS version by turning on or restarting the computer, pressing
the esc key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the
screen, and then pressing the 1 key. Follow the on-screen instructions to exit this screen.

Downloading a BIOS update

/\ CAUTION: CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation,
download and install a BIOS update only when the computer is connected to reliable external power
using the AC adapter. Do not download or install a BIOS update while the computer is running on
battery power, docked in an optional docking device, or connected to an optional power source.
During the download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Suspend or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Open your web browser. For U.S. support, go to http://www.hp.com/go/contactHP. For
worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want
to download.

3. Click the option for software and driver downloads, type your computer model number in the
product box, and then press enter. Follow the on-screen instructions to identify your computer and
access the BIOS update you want to download.

Click your specific product from the models listed.
Click the appropriate operating system.

Go to the BIOS section and download the BIOS software package.

N s » s

Follow the installation instructions as provided with the downloaded BIOS software package.
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Using Advanced System Diagnostics

Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware
is functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:

e  Start-up test—This test analyzes the main computer components that are required to start the
computer.

®  Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

®  Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

®  Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

e  Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.
If the battery fails the test, contact support to report the issue and purchase a replacement battery.

e  System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests
on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

You can view system information and error logs in the Advanced System Diagnostics window.
To start Advanced System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press 2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

@NOTE: If you need to stop a diagnostics test while it is running, press esc.
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6 Specifications

Computer specifications

Metric u.s.
Dimensions
Width 30.52 cm 12.02 in
Depth 20.90 cm 8.23 in
Height (front to rear) 2.74 to 3.28 cm 1.08 to 1.29 in
Weight (equipped with lightest display assembly, one 1.63 kg 3.59 lbs
memory module, solid-state drive, webcam, 3-cell battery,
and WLAN module)
Input power
Operating voltage and current 18.5Vdc @ 3.5A or 19.5 V dc @ 3.33A - 65W

19V dc@4.74A or 19.5V dc @ 4.62A - 90W

Temperature
Operating 5°C to 35°C 41°F to 95°F
Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15mto 3,048 m -50 ft to 10,000 ft

Nonoperating -15mto 12,192 m -50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this
range of temperatures.
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12.5-inch SGA display specifications

Metric u.s.
Dimensions
Height 15.70 cm 6.18in
Width 27.80 cm 10.95in
Diagonal 31.80 cm 12.52 in

Number of colors

up to 16.8 million

Contrast ratio

200:1 (typical)

Brightness

200 nits (typical)

Pixel resolution

Pitch

0.197 X 0.197 mm

Format

1366 x 768

Configuration

RGB vertical stripe

Backlight LED
Character display 80 x 25
Total power consumption 20w

Viewing angle

+65° horizontal, +£50° vertical (typical)

12.5-inch SGA display specifications
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Hard drive specifications

750-GB* 500-GB* 320-GB*
Dimensions
Height 9.5 mm 9.5 mm 9.5 mm
Length 100.2 mm 100.4 mm 100.4 mm
Width 69.9 mm 69.9 mm 69.9 mm
Weight 110 g 110g 110 g
Interface type SATA SATA SATA
Transfer rate
Synchronous (maximum) 1.1 GB/sec 1.1 GB/sec 1.1 GB/sec
Security ATA security ATA security ATA security
Seek times (typical read, including setting)
Single track 2.0 ms 1.5 ms 1.5ms
Average (read/write) 12/16 ms 11/13 ms 11/13 ms
Maximum 22 ms 22 ms 22 ms
Logical blocks 1,465,149,168 976,773,168 628,142,448
Disk rotational speed 7200 rpm 7200 rpm 7200 rpm
Operating temperature 0°C to 60°C (32°F to 140°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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7 Backup and recovery

Windows 8

To protect your information, use Windows backup and restore utilities to back up individual files and
folders, back up your entire hard drive, create system repair media (select models only) by using the
installed optical drive (select models only) or an optional external optical drive, or create system restore
points. In case of system failure, you can use the backup files to restore the contents of your computer.

From the Start screen, type restore, click Settings, and then select from the list of displayed options.

E%fNOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in Help and Support. From the Start screen, type h, and then select Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for
later use.

E’%NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information. From the Start
screen, type h, and then select Help and Support.

Backing up your information

Recovery after a system failure is as good as your most recent backup. You should create system repair
media and your initial backup immediately after initial system setup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup. As you add new software and data files, you should continue to back up your system
on a regular basis o maintain a reasonably current backup. The system repair media (select models
only) are used to start up (boot) the computer and repair the operating system in case of system
instability or failure. Your initial and subsequent backups allow you to restore your data and settings if
a failure occurs.

From the Start screen, type backup, click Settings, and then select Save backup copies of your
files with File History.

You can back up your information to an optional external hard drive or a network drive.
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Note the following when backing up:
e  Store personal files in the Documents library, and back it up regularly.
e Back up templates that are stored in their associated programs.

e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a backup using Backup and Restore:

@NOTE: Be sure that the computer is connected to AC power before you start the backup process.

@NOTE: The backup process may take over an hour, depending on file size and the speed of
the computer.

1. From the Start screen, type backup, click Settings, and then select from the list of
displayed options.

2. Follow the on-screen instructions to set up your backup, create a system image (select models

only), or create system repair media (select models only).

Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

®  Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

e {11 recovery tools: You can use the {11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

@NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
media you previously created (select models only), you must purchase Windows 8 operating system
media to reboot the computer and repair the operating system. For additional information, see the
“Using Windows 8 operating system media (purchased separately)” section.

Using the Windows recovery tools
To recover information you previously backed up:
A From the Start screen, type h, and then select Help and Support.

To recover your information using Startup Repair, follow these steps:
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/\ CAUTION: Some Startup Repair options will completely erase and reformat the hard drive. Al files
you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. |If possible, check for the presence of the HP Recovery partition and the Windows partition.
From the Start screen, type e, and then click File Explorer.
—or—

From the Start screen, type c, and then select Computer.

%/%"NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 8 operating system DVD and the Driver
Recovery media (both purchased separately). For additional information, see the “Using Windows
8 operating system media (purchased separately)” section.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer. After
Windows has loaded, press and hold the shift key while clicking Restart.

4. Select Startup Repair.

5. Follow the on-screen instructions.

=2 NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support. From the Start screen, type h, and then select
Help and Support.

Using f11 recovery tools

/\ CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
that you have created and any software that you have installed on the computer are permanently
removed. The {11 recovery tool reinstalls the operating system and HP programs and drivers that were
installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:
1. If possible, back up all personal files.

2. |If possible, check for the presence of the HP Recovery partition: From the Start screen, type c, and
then select Computer.

@NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 8 operating system media and the Driver Recovery media (both
purchased separately). For additional information, see the “Using Windows 8 operating system
media (purchased separately)” section.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.
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4. Press {11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using Windows 8 operating system media (purchased separately)

To order a Windows 8 operating system DVD, go to http://www.hp.com/support, select your country
or region, and follow the on-screen instructions. You can also order the DVD by calling support. For
contact information, see the Worldwide Telephone Numbers booklet included with the computer.

/\ CAUTION: Using a Windows 8 operating system media completely erases hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on the
computer are permanently removed. When reformatting is complete, the recovery process helps you
restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 8 operating system DVD:

@NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 8 operating system DVD into the optical drive
before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 8 operating system media and then insert the Driver Recovery media.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.

Using Windows Refresh for quick and easy recovery

When your computer is not working properly and you need to regain system stability, the Windows
Refresh option allows you to start fresh and keep what is important to you.

@IMPORTANT: Refresh removes any traditional applications that were not originally installed on the
system at the factory.

@NOTE: During Refresh, a list of removed traditional applications will be saved so that you have a
quick way to see what you might need to reinstall. See Help and Support for instructions on reinstalling
traditional applications. From the Start screen, type h, and then select Help and Support.

@NOTE: You may be prompted for your permission or password when using Refresh. See Windows
Help and Support for more information. From the Start screen, type h, and then select
Help and Support.
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To start Refresh:

1.

On the Start screen, point to the far-right upper or lower corner of the screen to display
the charms.

Click Settings.

Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

Under Refresh your PC without affecting your files, select Get started, and follow the
on-screen instructions.

Remove everything and reinstall Windows

Sometimes you want to perform detailed reformatting of your computer, or you want to remove
personal information before you give away or recycle your computer. The process described in this
section provides a speedy, simple way to return the computer to its original state. This option removes
all personal data, apps, and settings from your computer, and reinstalls Windows.

E’jIMPORTANT: This option does not provide backups of your information. Before using this option,
back up any personal information you wish to retain.

You can initiate this option by using the 11 key or from the Start screen.

To use the f11 key:

1.

2,
3.

Press f11 while the computer boots.

—or-

Press and hold 11 as you press the power button.
Select Troubleshoot from the boot options menu.

Select Reset your PC, and follow the on-screen instructions.

To use the Start screen:

1.

On the Start screen, point to the far-right upper or lower corner of the screen to display
the charms.

Click Settings.

Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

Under Remove everything and reinstall Windows, select Get started, and follow the
on-screen instructions.

Windows 8
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Using HP Software Setup

HP Software Setup can be used fo reinstall drivers or select software that has been corrupted or deleted
from the system.

1.

From the Start screen, type HP Software Setup, and select Apps.

2. Open HP Software Setup.

3.

Follow the on-screen directions to reinstall drivers or select software.

Windows 7

To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only) with
the installed optical drive (select models only) or an optional external optical drive, or create system
restore points. In case of system failure, you can use the backup files to restore the contents of

your computer.
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Windows Backup and Restore provides the following options:

Creating a system repair disc (select models only) by using the installed optical drive (select
models only) or an optional external optical drive

Backing up your information

Creating a system image (select models only)
Scheduling automatic backups (select models only)
Creating system restore points

Recovering individual files

Restoring the computer to a previous state

Recovering information using recovery tools

@NOTE: For detailed instructions, perform a search for these topics in Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for
later use.

E/?’NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. See Help and Support for more information.
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Creating recovery media with HP Recovery Disc Creator

HP Recovery Disc Creator is a software program that offers an alternative way to create recovery
media. After you successfully set up the computer, you can create recovery media using HP Recovery
Disc Creator. This recovery media allows you to reinstall your original operating system as well as
select drivers and applications if the hard drive becomes corrupted.

HP Recovery Disc Creator can create two kinds of recovery DVDs as follows:
®*  Windows DVD—Installs the operating system without additional drivers or applications.

e Driver DVD—Installs specific drivers and applications only, in the same way that the HP Software
Setup utility installs drivers and applications.

Creating recovery media

E’%NOTE: The Windows DVD can be created only once. Thereafter, the option to create that media will
not be available.

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.
2. Select Driver DVD or Windows DVD.

3. From the drop-down menu, select the drive for burning the recovery media.

4

Click the Burn button to start the burning process.

Backing up your information

Recovery after a system failure is as good as your most recent backup. Immediately after setting up the
computer, you should create system repair discs (select models only) using the installed optical drive
(select models only) or an optional external optical drive and back up your system. As you add new
software and data files, you should continue to back up your system on a regular basis to maintain a
reasonably current backup. The system repair discs (select models only) are used to start up (boot) the
computer and repair the operating system in case of system instability or failure. Your initial and
subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:

®  Store personal files in the Documents library, and back it up regularly.

®  Back up templates that are stored in their associated programs.

e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

®  When backing up to discs, use any of the following types of discs (purchased separately): CDR,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD+RW. The discs you use will depend on the
type of optical drive you are using.

Windows 7 127



@NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

e When backing up to discs, number each disc before inserting it into the external drive.

To create a backup using Backup and Restore:

@NOTE: Be sure that the computer is connected to AC power before you start the backup process.

@NOTE: The backup process may take over an hour, depending on file size and the speed of
the computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select
models only), or create a system repair disc (select models only).

Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

®  Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

o

f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

@NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair discs
you previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. For additional information, see the Using a
Windows 7 operating system DVD (purchased separately) section.

Using the Windows recovery tools
To recover information you previously backed up:
1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select
models only), or your files.

To recover your information using Startup Repair, follow these steps:

/\ CAUTION: Some Startup Repair options completely erase hard drive contents and reformat the hard
drive. All files you have created and any software installed on the computer are permanently removed.
When reformatting is complete, the recovery process restores the operating system, as well as the
drivers, software, and utilities from the backup used for recovery.

1. |If possible, back up all personal files.
2. |If possible, check for the presence of the Windows partition.

To check for the Windows partition, select Start > Computer.
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3. If the Windows partition is listed, restart the computer, and then press {8 before the Windows
operating system loads.

4. Select Startup Repair.

5. Follow the on-screen instructions.

E"jNOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11 recovery tools

/\ CAUTION: Using 11 recovery tools completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently removed.
The f11 recovery tool reinstalls the operating system and HP programs and drivers that were installed at
the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:
1. If possible, back up all personal files.

2. |f possible, check for the presence of the HP Recovery partition: click Start, right-click Computer,
click Manage, and then click Disk Management.

@NOTE: If the HP Recovery partition has been deleted, the {11 restore option will not function.
You must recover your operating system and programs using the Windows 7 operating system
DVD and the Driver Recovery disc (both purchased separately) if the Windows partition and the
HP Recovery partition are not listed. For additional information, see the Using a Windows 7
operating system DVD (purchased separately) section.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press 11 while the “Press <F11>" for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Using a Windows 7 operating system DVD (purchased separately)

To order a Windows 7 operating system DVD, go to the HP website. For U.S. support, go to

http:// www.hp.com/go/contactHP. For worldwide support, go to http://welcome.hp.com/country/
us/en/ wwcontact us.html. You can also order the DVD by calling support. For contact information,
see the Worldwide Telephone Numbers booklet included with the computer.

/\ CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD:

@NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive
before the Windows operating system load:s.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 7 operating system DVD, and then insert the Driver Recovery disc.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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SuUSE Linux (SLED)

Recovery after a system failure is as good as your most recent backup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup.

Your computer includes tools provided by HP to help you safeguard your information and retrieve it if

ever needed.

Creating backups

1. Create restore media immediately after you set up the computer. For more information, see the
“Performing a system recovery” section.

2. Asyou add files, routinely create a backup of your system and personal information.

Backing up your information

You should back up your computer files on a regular schedule to maintain a current backup. You can
manually back up your information to an optional external drive, a network drive, or discs. Back up
your system at the following times:

e  Atregularly scheduled times

e  Before the computer is repaired or restored

e  Before you add or modify hardware or software

To back up your home directory files using Backup Manager Settings:

1. Select Computer > More Applications > Tools > Backup Manager Settings, and click
Backup my home directory.

2. Click Storage Destination Location, and then select a location to back up your information.

3. Click Schedule, and then select a time schedule to perform backups at a regularly scheduled
time.

To immediately back up your information, click the Backup Now check box.

@NOTE: Before you back up your information, be sure you have designated a location to save
the backup files.

4. Click Save and Backup to start the backup and to save the backup settings.

To restore backup files:

1. Select Computer > More Applications > Tools > Backup Manager Restore.
2. Click Backup Source, and then select the location of the backup files.

3. Click Restore Destination, and then select the destination to restore the files.
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4. To restore all files from the selected location, click Restore all files. To restore select files only,
click Restore selected files, click Select Files and then select the files to be restored.

5. Under Restore Point, click the time and date of the backup.

[Bf NOTE: If multiple backups have been performed, click Use the latest version fo restore the
|latest version.

6. Click Restore to start restoring the files, or click Cancel to cancel the operation.

Performing a system recovery

Recovery allows you to repair or restore the computer to its original factory state. You can create an HP
Factory Image Restore DVD, using an installed or an external DVD+RW optical drive.

/\ CAUTION: CAUTION: Using Recovery completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently removed.
The recovery tool reinstalls the original operating system and HP programs and drivers that were
installed at the factory. Software, drivers, and updates not installed by HP must be manually reinstalled.
Personal files must be restored from a backup.

To restore the computer using the HP Factory Image Restore DVD, you must first create the recovery
disc. To create the recovery disc:

@NOTE: HP recommends that you create the HP Factory Image Restore DVD in the event of a system
failure.

1. Select Computer > More Applications.

2. In the left pane, click Tools, and then click Create HP Factory Image Restore DVD in the
right pane.

3. Follow the on-screen instructions to create an image file to burn a recovery disc.

To restore the computer from the recovery disc, follow these steps:

1. |If possible, back up all personal files.

Insert the HP Factory Image Restore DVD into the optical drive and restart the computer.

As the computer is restarting, press {9 to open the Computer Setup boot option menu.

Ll S

Press the down arrow to select Restore SLED HP-BNB preload image from the Linux boot
menu, and then press enter.

5. Using the arrow keys, select Yes when prompted: Do you want to start the System-
Restore?

6. Follow the on-screen instructions.
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USB Recovery option (select models only)

The USB Recovery Disk On Key (flash drive) option allows you to create a backup image of the SLED
operating system installed on select HP Business Notebooks. This Disk On Key may be used to restore
the system to the original factory state when the F11 recovery option is not available. This process
should be done on first obtaining the computer.

/\ CAUTION: The USB recovery option does not preserve data present on the computer’s hard drive or
on the Disk On Key used for the recovery process. Back up any data on the Disk on Key or the
notebook that will be recovered before starting.

@NOTE: HP recommends that you create the USB Recovery Disk in the event of a system failure. The
Disk On Key used for this process should be 4 GB or larger.

Creating a USB Recovery Disk On Key

1. Connect the USB Disk On Key to a USB port on the computer.

Select Computer > More applications > Tools > Create Recovery USB.
Enter the root password when prompted.

Select USB Disk On Key from the list.

Click OK.

A O T o

A question dialog will remind you that the data on the USB key will be destroyed. To continue,
click OK. Otherwise, click Cancel and back up the contents of the Disk On Key on another
computer.

7. The backup process will display a status dialog box while the backup is in progress.

@NOTE: A file browser window with the Disk On Key Contents displayed will pop up when the
key is mounted. You may close the file browser window if desired. Once the USB Recovery Key
has been created, the status dialog will close. The USB Recovery Key is ready for use.

Recovering from a USB Recovery Disk On Key

/\ CAUTION: Before starting the Recovery process, make sure any data on the system to be recovered
has been backed up. The recovery process destroys all data on the system to be recovered.

1. Turn off the computer.
Connect the USB Disk On Key to a USB port on the computer.
Turn on the computer while holding down the 9 key.

Once the system has booted, the Boot Options menu should appear.

b R

Using the arrow keys, select USB Disk On Key and press enfer.

@NOTE: The description may vary from one USB key to another. Any entry other than Optical
Disk Drive, Notebook Hard Drive or Notebook Ethernet should be the USB Recovery Disk On Key.

6. Once the USB Recovery Disk On Key has been selected, press enter. The USB Recovery Disk On
Key will boot.
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7. Once the USB Recovery Disk On Key has booted, a dialog box will prompt, “Do you want to start
the System-Restore?” If data on the computer has not been backed up, use the tab key and select
No. The system will reboot. Back up the system data and repeat the previous steps. If no data
should be saved from the computer, use the tab key to select Yes. Press enter to begin the
recovery process.

8. Atter the files are copied to the system, follow the on-screen instructions.

Remove everything and reinstall SLED

Sometimes you want to perform detailed reformatting of your computer, or you want to remove
personal information before you give away or recycle your computer. The process described in this
section provides a speedy, simple way to return the computer fo its original state. This option removes
all personal data, applications, and settings from your computer, and reinstalls the Linux operating
system.

@IMPORTANT: This option does not provide backups of your information. Before using this option,
back up any personal information you wish to retain.

You can initiate this option by using the {11 key.

To use the 11 key:

Press {11 while the computer boots.

—or-

Press and hold {11 as you press the power button.

The following options are available:

e Cancel/Reboot—Reboots the system. No recovery or restore activity is performed.

®  Recover/Repair System—This option repairs a system that is not working properly and preserves
user data.

®  Restore Factory System—This option restores the system back to the original factory state. User
data is not preserved.

Select an option and follow the on-screen instructions.
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8 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries

The following requirements are applicable to all countries and regions:
e The length of the power cord set must be at least 1.0 m (3.3 ft) and no more than 2.0 m (6.5 ).

e All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

®  The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

e The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region Accredited agency Applicable note number
Australia EANSW 1
Austria OVE 1
Belgium CEBC 1
Canada CSA 2
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
Italy IMQ 1
Japan METI 3
The Netherlands KEMA 1
Norway NEMKO 1
The People's Republic of China CocC 5
South Korea EK 4
Sweden SEMKO 1
Switzerland SEV 1
Taiwan BSMI 4
The United Kingdom BSI 1
The United States uL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm? conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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9 Recycling

When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose

of the battery in general household waste. Follow the local laws and regulations in your area for
battery disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and

rechargeable batteries. For more information about recycling programs, see the HP Web site at
http://www.hp.com/recycle.
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buttons
keyboard light 10
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pointing stick 14
power 11

TouchPad 14
TouchPad on/off 14
volume mute 11
web browswer 11
wireless 11

C
Cable Kit

components 31

spare part number 31, 36
cables, service considerations 43
caps lock light 13
carrying case, spare part
numbers 34, 35
chipset, product description 1
components

bottom 19

buttons 10

display 9

fingerprint reader 10

front 15

keys 12

leftside 16

lights 13

rear 17

rightside 18

TouchPad 14
computer feet

location 49

spare part number 49
computer major components 23
computer part number 48
computer specifications 118
connectors, service
considerations 43

D
display
components 9
specifications 119
subcomponents 29
display bezel
removal 95
spare part numbers 29, 37,
96
Display Cable Kit, spare part
number 30, 38, 102
display clutch cover
removal 100
spare part number 37, 101
display enclosure, spare part
number 30, 38
display hinge
removal 99
spare part number 30, 38,
100
display hinge cap
removal 99
spare part number 37, 100
display hinge cover
removal 99
spare part number 37, 100
Display Hinge Cover Kit, spare part
number 30, 37, 100
Display Hinge Kit, spare part
number 30, 38, 100
display panel
product description 1
removal 96
spare part number 30, 38, 98
display panel cable
removal 101
spare part number 30, 38,
102



Display Panel Support Kit, spare
part number 30, 38
Display Screw Kit, spare part
number 30, 38
DisplayPort 18
docking connector 18
docking station, spare part
number 34, 37
drive light 15
drives, preventing damage 44
DVD-ROM Drive
precautions 44
removal 57
spare part number 27, 32,
38, 57
DVD+RW Double-Layer with
SuperMulti Drive
precautions 44
removal 57
spare part number 27, 32,
38, 57

E

electrostatic discharge 44

equipment guidelines 47

eSATA/USB 2.0 combo port 18

esc key 12

Ethernet, product description 3

ExpressCard slot space saver,
illustrated 33

ExpressCard slot, location 18

external monitor port 17

F
fan

removal 60

spare part number 28, 36, 60
feet

location 49

spare part number 49
fingerprint reader 11
fingerprint reader board

removal 86

spare part number 26, 37, 86
fingerprint reader component 10
fnkey 12
front component 15
function button board

removal 89

spare part number 26, 37, 89

function keys 12
function LED board
removal 94
spare part number 26, 38, 94

G
graphics, product description 1
grounding guidelines 44
guidelines
equipment 47
grounding 44
packaging 46
transporting 46
workstation 46

H
hard drive
precautions 44
product description 2
removal 58
spare part numbers 28, 32,
36, 37, 58
specifications 120
hard drive bracket
illustrated 32
removal 59
hard drive connector adapter
illustrated 32
removal 59
Hard Drive Hardware Kit
contents 32
spare part number 28, 32,
36, 58
headphone jack 18
heat sink
removal 81
spare part number 27, 38, 81

J

jacks
audio-in 18
audio-out 18
headphone 18
microphone 18
modem 16
network 16
RI-1T 16
RI-45 16

K
key components 12

keyboard
product description 4
remval 69

spare part numbers 24, 38,
39, 40, 41, 42, 69
keyboard light 10

keyboard light button 10

keys
esc 12
fh 12

function 12
Windows applications key 12
Windows logo key 12

L
Latch Kit, spare part number 27,
38
left-side components 16
light components 13
lights
battery 15
caps lock 13
drive 15
keyboard 10
mute 13
num lock 13
optical drive 16
power 13,15
TouchPad 13
web browser 13
webcam 9
wireless 13, 15

lock, spare part numbers 34, 35

M
mass storage device

illustrated 32

precautions 44

spare part numbers 32
Media Card Reader, location 18
memory module

product description 1

removal 53

spare part numbers 36, 53
microphone

location 9

product description 2
microphone jack 18
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microphone module
removal 99
spare part number 30, 38, 99
model description 49
model name 1
modem jack 16
modem module
removal 68
spare part number 27, 36, 68
modem module cable, illustrated
31
monitor port 17
mouse, spare part numbers 34,
35
mute light 13

N

network jack 16

num lock light, location 13
numeric keypad 12

o
operating system, product
description 5
optical drive
location 16
product description 2
removal 57
spare part numbers
38, 57
optical drive bay space saver,
illustrated 33
optical drive light 16

27, 32,

P
packaging guidelines 46
plastic parts, service
considerations 43
Plastics Kit
components 33
spare part number 33, 36
pointing device, product
description 4
pointing stick 14
pointing stick button 14
ports
DisplayPort 18
eSATA/USB 2.0 combo 18
external monitor 17
monitor 17
product description 4
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UsB 17

USB 3.0 17

power button 11

power button board

removal 91

spare part number 26, 37, 91

power connector 16

power cord

set requirements 135
spare part numbers 34, 35

power light 13, 15

power requirements, product
description 4

processor

product description 1
removal 84
spare part numbers
84

product description
audio 2
chipset 1
display panel 1
Ethernet 3
external media cards 4
graphics 1

hard drive 2
keyboard 4
memory module 1
microphone 2
operating system 5
optical drive 2
pointing device 4
ports 4

power requirements 4
processors |
product name 1
security 5
serviceability 8
solid-state drive 2
video 2

wireless 3

product name 1, 48

product number 48

26, 37,

R

rear components 17

removal/replacement
preliminaries 43
procedures 48

rightside components 18

R-11 jack 16
RJ-11 jack plug, illustrated 33
RJ-45 jack 16
RTC battery

removal 72

spare part number 26, 36, 72
Rubber Kit, spare part number

27, 36

S
Screw Kit, spare part number 35,
38
security cable slot 18
security, product description 5
serial number 48
service considerations
cables 43
connectors 43
plastic parts 43
service cover
location 19
removal 52
spare part numbers
42,52
service cover release latch 19
service tag 22, 48
serviceability, product description
8
SIM slot, location 19
SIM, removal 51
Smart Card reader assembly
removal 92
spare part number 26, 38, 92
Smart Card reader, location 16
solid-state drive
precautions 44
product description 2
spare part numbers 28, 32,
40
speaker assembly
removal 56
spare part number 27, 36, 56
speaker, location 20
specifications
computer 118
display 119
hard drive 120

28, 37,



system board
removal 79
spare part numbers 26, 37,
38,79

T
tools required 43
top cover

removal 87

spare part numbers 26, 37,

87

TouchPad button 14
TouchPad components 14
TouchPad light 13
TouchPad on/off button 14
TouchPad zone 14
transporting guidelines 46

u

USB 3.0 port 17
USB port 17

\'

vents 15, 18, 20
video, product description 2
volume mute button 11

w

warranty period 49

web browser button 11

web browser light 13

webcam 10

webcam light 9

webcam/microphone module
removal 99

spare part number 30, 37, 99

Windows applications key 12
Windows logo key 12
wireless antenna
locations 9
removal 102, 103
spare part number 30, 38,
103, 104
Wireless Antenna Kit, spare part
number 103
wireless button 11
wireless light 13, 15
wireless, product description 3

WLAN module
removal 65
spare part numbers

37, 65

27, 36,

workstation guidelines 46

WWAN module
removal 61

spare part numbers
42, 61

27, 36,

Index
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